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LAB TIPS 
 
 There are some important issues to keep in mind as you do these lab experiments and 
record your observations.  Following these suggestions is practically guaranteed to substantially 
increase both your lab scores and your enjoyment of the experience. 
 
1.  Read the write-up of the experiment before coming to lab and try to visualize yourself doing 
the experiment.  Such preparation will help you and your group perform the measurements more 
efficiently than coming in “cold.”  This will also allow you to pace yourself during the lab, so that 
you will finish, hopefully with time to spare.  Be an asset to your team, not a liability. 
 
2.  Entries in the lab notebook should be in pencil; feel free to erase.  Writing should be large and 
dark enough to be read easily.  Each lab should have a title at the top of the first page of the 
entry.  Write using complete sentences, so that someone who wasn’t there during the experiment 
would be able to read your notebook and have a good idea of what happened.  In particular, avoid 
at all costs starting sentences (answers to questions) with the words “yes” and “no.”  Remember 
that your work will be read by others, so NEATNESS COUNTS! 
 
3.  UNITS: Don’t forget to indicate the units (where appropriate) on all numerical values.  If these 
are recorded in a chart, you can indicate the units at the top of a column.  By far the most 
common deficiency in lab entries is failure to give units the proper respect! 
 
4.  Show sample calculations to indicate how data is being combined to produce a calculated 
result, and how uncertainties are being estimated.  Results should be reported in a form (i.e. with 
a number of significant figures) consistent with its uncertainty.  Please note that it is almost never 
appropriate to report an uncertainty with more than one significant figure! 
 
5.  GRAPHS: Graphed data should take up at least half a page if feasible.  If you are graphing a 
few data points (as opposed to the continuously recorded output of one of the sensors), make sure 
to plot the data points clearly and indicate the curve that best fits them.  Don’t forget to label the 
axes with the quantity being plotted (e.g., “time,” “voltage,” etc.) along with the units.  Always 
give the graph a title (nothing fancy—just say what’s being plotted).  When comparing 
predictions and observations, you can use the same set of axes for both graphs—just be sure to 
distinguish the two plots (with, e.g., solid and dashed lines, or with different colors).  Please do 
not put arrowheads on the ends of best-fit lines! 
 
6.  If your observations or calculations give results that are so far from those that you expect that 
something must be wrong and you and your group can’t figure it out, ask the instructor for help. 
 
7.  Always write a conclusion in which you answer the indicated questions at the end of the write-
up.  Try to base your statements on what you and your partners actually observed. 
 
8.  Always review graded labs for comments intended as feedback.  Don’t make the same mistake 
twice! 
 
9.  Laptop Usage:  The laptops are intended as read only devices: do not leave files on the disk or 
alter the desktop in any way.  Deliberate and malicious changes to the laptops will be considered 
vandalism and as such will be subject to disciplinary action. 
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10.  Courtesy: As a courtesy to your group, to the class, and to the instructor, don’t come in late to 
lab.  Do not write on the tabletop.  Backpacks must NOT be placed in the aisles (stow them under 
the table or by the entrance).  Before you leave: Clean up any cups, wrappers, etc. from your 
work area as a courtesy to the next group and to the lab technician.  Put everything back the way 
it was when you started.  Report broken apparatus immediately.  The cell phone policy stated in 
the syllabus applies in lab as well. 
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Electrostatic Forces and Coulomb’s Law 
 
 Introduction.  In this set of experiments, you will investigate the forces between charges.  
In part I, you will do this qualitatively by producing excess charges on objects and observing the 
attraction or repulsion they exhibit for each other.  In part II you will do a more careful 
quantitative assessment of the way the force between two charged objects behaves as a function 
of the distance between them.  You can then compare your result to the prediction of Coulomb’s 
law. 
  

Procedure.  You will need the following: 
 
• Scotch tape in dispenser • 2 small rod stands 
• aluminum foil pieces • long thin plastic strip 
• 1 ea. hard plastic/Lucite/glass rod • 1 fur piece 
• Styrofoam packing peanut on a string • 1 silk cloth 
• 2 metal rods • 2 right angle clamps 
• laptop • string and scissors 
• Coulomb balance apparatus with two 

5kV high voltage supplies (back bench) 
• 1 ea. conducting/insulating 

pith ball (5 mm) 

• Van de Graaff generator with insulated 
conducting sphere (front bench) • French curve 

 
 

I.  Qualitative  Observations.  The nature of electrical interactions is not obvious without 
careful experimentation and reasoning.  We will first state two hypotheses about electrical 
interactions.  You will then observe some of these interactions and determine whether your 
observations are consistent with these hypotheses. 
 

Hypothesis One:  The interaction between two objects that have been rubbed is due to a 
property of matter that we will call charge.  There are two types of electrical charge that 
we will call, for the sake of convenience, positive charge and negative charge. 
 
Hypothesis Two:  Excess charge moves readily on certain materials, known as 
conductors, and not on others, known as insulators.  In general, metals are good 
conductors, while glass, rubber, and plastic tend to be insulators. 
 

Note:  In completing the following activities, you should not report outcomes based on 
assumptions or previous experience.  You must report your actual observations and devise a 
sound and logical set of reasons to support (or refute) the hypotheses. 
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Hypothesis One: Testing for Different Types of Charge 
 

1.  Interactions of Scotch Tape Strips 
  
(a)  Stick two 15 cm (or so) strips of Scotch tape side by side on the back of a chair; the 
end of each tape should be curled to make a non-stick handle.  Peel the strips off the chair 
and bring the non-sticky side of the tapes toward each other.  What happens?  How does 
the distance between tapes affect the interaction between them? 
 
(b)  Stick two strips of tape on the chair and label them “B” for bottom.  Press another 
strip of tape on top of each of the B pieces; label these strips “T” for top.  Pull each pair 
of strips off the chair.  Then pull the T and B strips apart. 
i.)  Describe the interaction of the two T strips when they are brought toward one another. 
ii.)  Describe the interaction between the two B strips. 
iii.)  Describe the interaction between a T strip and a B strip. 
 
(c)  Are your observations of the tape strip interactions consistent with the hypothesis that 
there are two types of charge?  Please explain your answer carefully, in complete 
sentences, and cite the outcomes of all your observations. 
 

2.  Charging Insulators with Rods 
 
(a)  Use tape to secure a doubled-over strip of thin plastic1 to a horizontal rod so that the 
two approximately equal lengths hang facing each other.  Try rubbing the black plastic 
rod with fur and then use the rod to rub the facing surfaces of the plastic strips near the 
bottom.  What happens to the hanging pieces?  What happens when you rub the rod with 
the fur again and bring it near the pieces? 
 
(b)  What happens if you now immediately rub a glass rod with silk and then bring it into 
the vicinity of the strips where they were rubbed by the plastic rod? 
 
(c)  Recalling the interactions between like and unlike charged objects that you observed 
before, can you explain your observations? 
 
(d)  Touch the entire surface of the plastic strip with your hands.  Now what happens 
when you let them hang again?  Is there an interaction between them? 
 

Note: Benjamin Franklin arbitrarily assigned the term “negative” to the nature of the charge 
acquired by the hard plastic (or rubber) rod when it is rubbed with fur.  Conversely, the nature of 
the charge found on the glass rod after it is rubbed with silk is defined as “positive.” 
 
Hypothesis Two: Using Induction to Distinguish Conductors from Nonconductors 

                                                 
1 If the strip appears to be already charged, you may need to discharge it with your hand or by moistening and then drying it. 
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A neutral object with no external influences has equal numbers of both kinds of charges that, in 
general, are distributed uniformly.  In the presence of external charges, however, the positive and 
negative charges in the body, since they feel different forces, can be induced to separate so that 
the body as a whole feels a net force.  This phenomenon is known as electrostatic induction. 
 
3.  Insulators, Conductors and Induction 
 
Using pieces of Scotch tape, hang two small pith balls--one coated (conducting) and one 
uncoated (insulating)--by their threads from a horizontal bar.  Space them as far apart as 
possible, and touch each one to make sure it is uncharged. 
 

(a)  What happens when you rub the Lucite rod with the fur and bring it near the 
uncharged insulating pith ball-- 
i.) Before they touch? 
ii.) Now immediately charge the rod again and bring it near the area that was just touched 
as well as near an area that was not touched.  What happens? 
 
(b)  Repeat observation (a) using the hanging uncharged conducting pith ball..  What 
happens-- 
i.) Before they touch? 
ii.) After they touch (bring the rod near both touched and untouched areas)? 
 
(c)  Use Hypothesis Two, which claims that charges move readily on conductors, to 
explain why the conducting pith ball is attracted to the rod before touching and repelled 
after touching it. 
 
(d)  Use Hypothesis Two, which claims that if an object is an insulator, its electrons will 
stay in the vicinity of their atoms, to explain the behavior of the insulating pith ball after 
being touched by the rod. 
 
(e)  Watch the video AlPan&FoamBoard.mov, which should be available on your 
desktop in the folder Electrostatics Videos.  Explain the behavior of the charged strips 
using what you’ve learned about electrostatic forces. 
 

II.  Quantitative Investigation: Coulomb’s Law 
 

Coulomb’s law is the basis for the calculation of the electrical forces that act between 
charged objects.  The law applies specifically to the simplest case of two “point” charges (q1 and 
q2) separated by a distance r.  These charges experience a mutual force given as 

 1 2
Coul 2

q q
F = k ,

r
 (1) 

where ke is the Coulomb constant, and has a value of 8.99 × 109 N⋅m2/C2.  The force is attractive 
if 1 2q q 0< and repulsive if 1 2q q 0> .  Application of the principle of superposition shows that 
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Eq. (1) also applies to two uniformly charged spheres.  (This is a good thing, since point charges 
are hard to find.) 
  

 In this experiment you will use the Coulomb 
balance pictured at the right to determine how the force 
between two identical spheres with equal positive 
charges depends on the distance r between their centers.  
For each value of r (varied by moving the sliding sphere) 
the electrostatic force on the sphere suspended on the 
torsion thread is balanced by twisting the thread, using the knob at the top, so that the sphere 
returns to its initial angular position.  The angle scale then indicates the amount of twist (and 
hence the torque) exerted by the thread, which is now equal to the torque due to the charges.  
Since the lever arm is constant, the angle reading for each distance is proportional to the mutual 
force of repulsion between the charged spheres. 

 
Procedure.  The Coulomb balance should be already adjusted for the experiment.  Make 

sure that the torsion balance is zeroed by setting the dial at the top to zero and rotating the 
bottom torsion wire retainer until the pendulum assembly is at its zero displacement position as 
indicated by the index marks.  When both spheres are discharged, they should just touch when 
the position marker for the sliding sphere reads 3.8 cm, which is the sphere diameter; the 
thumbscrew on the top of the rod supporting the sliding sphere can be loosened and the position 
of this sphere can be adjusted so that this latter condition is met.  The high voltage supply should 
be set at about 8 kV and held constant so that the same charge is always delivered to the spheres 
by the charging probe. 

 
For each separation r for which the force is to be measured: 
 

1.  Move the spheres to their maximum separation and charge each one by briefly touching it 
with the charging probe connected to the high voltage supply. 
 
2.  Quickly move the sliding sphere until the scale indicator reads the desired separation r. 
 
3.  Turn the knob until the pendulum is brought back to zero displacement as indicated by the 
alignment of the index marks.  Record the distance r and the angle reading θ of the knob. 
 
4.  Repeat this measurement a few (two or three) times and obtain an average value of the angle 
reading, θ , corresponding to this value of r. 
 
5.  Each group should repeat this procedure for two different values of r between 20 cm and 
6 cm.  The data ( θ  vs. r) from all the groups for different r values should be combined for 
analysis. 
 

Analysis.  Open LoggerProFile.cmbl and produce a plot of θ (along the 
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y-axis) vs. the separation r (along the x-axis).  Try fitting the data2 (Analyze→Curve Fit) with a 
function of the form Ax^B.  Does your result agree with Coulomb’s law, Eq. (1)?  Make a 
careful sketch of this graph (data points with best-fit curve) in your notebook. 

 
The “Dipole” Correction:  It should be noted that Coulomb’s law 
actually applies directly only to point charges and, by extension, to 
uniformly charged spheres, as depicted at the right in (a).  Our 
spheres are conducting, so the positive charges on one sphere are 
free to move and respond to the repulsive force from positive 
charges on the other sphere.  As the spheres are brought into close 
proximity, the + charge distribution becomes more like that in (b), 
so we would expect a deviation from Coulomb’s law behavior for 
the force at distances r that are not large compared with the sphere 
radius a. 
 
 Conclusion.  Briefly summarize how your qualitative observations in part I support or 
contradict the two hypotheses given concerning the behavior of charge. 
 
 Do the results of your quantitative measurements of the interaction between two charged 
spheres support Coulomb’s law?  Explain. 
 
 Question:  Considering the “dipole” correction discussed above, how does your observed 
θ vs. r curve differ from the curve you would have obtained if your spheres represented actual 
“point” charges (or if the charge were uniformly distributed over their surfaces)?  Illustrate your 
answer by roughly sketching both the observed and “point charge” curves on the same axes for 
comparison. 
 

                                                 
2 You will first need to sort the data (use the Data menu). 
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The Millikan Oil Drop Experiment 
  
Introduction.  The American physicist R. A. Millikan, in a famous series of measurements 
performed around 1910, studied the motion of charged oil droplets between two charged plates.  
These experiments (a) showed that charge is quantized, i.e., appears only as multiples of an 
elementary unit of charge e; (b) produced a value for this charge e, and (c) helped Millikan win 
the Nobel prize in 1923.  We will perform a version of this historic experiment. 
 
 The oil drop apparatus is pictured schematically at 
the right.  By applying a potential difference (voltage) V 
between the two parallel plates separated by a distance d, a 

region of uniform electric field VE
d

=  is created between 

the plates.  Oil droplets are introduced into this region and 
their motion is observed after they reach terminal velocity 
under the influence of their weight, the electric field, and 
the resistive drag force due to the viscosity of the air.  By 
carefully measuring the terminal speeds, the charge on 
each drop can be determined, as described below. 
 
 The force diagrams for an oil droplet 
with a negative charge3 q are shown at the 
right (a) with the top plate negative and (b) 
with the top plate positive.  The size of the 
voltage V (and hence the magnitude E of the 
field) between the plates is the same for both 
polarities. 
 
  
For the situation depicted in (a), the droplet (of radius a) is pulled down under the influence of 
the electric field (FE = qE) and its weight gF mg= ; the viscous drag force FD acts upward and is 

given by Stokes’ law as *
D dF 6 av= πη , where vd is the terminal downward speed of the droplet 

and *η is the effective viscosity (see below) of the air.  Since the droplet is not accelerating, 
Newton’s second law gives 0= + =∑ D g EF F + F F , from which we get 

  *
d6 av mg q E 0πη − − = . (1) 

Note that the buoyant force on the droplet is neglected because it is small compared to its weight. 
 
 If the plates are charged so that the sphere moves upward with constant speed vu, as in 

                                                 
3 Although the charge on the droplet may be of either sign, we assume that q 0< for this 
calculation.  The sign of q on any droplet can always be determined by observing its 
direction of motion relative to the polarity of the voltage on the plates. 

V -
d q
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(b), the force balance again reads 0= + + =∑ D g EF F F F , which gives us 

 *
uq E mg 6 av 0− − πη = . (2) 

Eliminating *η  between Eqs. (1) and (2) gives the charge on the droplet in terms of the measured 
terminal up and down speeds4 vu and vd: 
 

 d u

d u

v vmgq
E v v

⎛ ⎞+
= ⎜ ⎟−⎝ ⎠

. (3) 

 
 We could calculate the charge q on any droplet from Eq. (3) if we knew its mass, but this 

must be calculated for each droplet from its radius: 34mass (volume)(density) m a
3

= ⇒ = π ρ , 

where ρ  is the density of the oil.  Plugging this expression for the mass into Eqs. (1) and (2), 
then eliminating the charge, would give for the radius a: 

 ( )
*

d u
9a v v
4g
η

= −
ρ

. (4) 

But the value of the effective viscosity *η is different from the “ordinary” viscosity η because the 
droplets are so small that their radii are comparable to the mean free path of air molecules.  In 
terms of the “ordinary” viscosity η , this effective viscosity *η  is given as 

 
1

* b1
pa

−
⎛ ⎞

η = η +⎜ ⎟
⎝ ⎠

, (5) 

where p is the atmospheric pressure and b is a constant (given below).  Substituting Eq. (5) for 
*η in Eq. (4) and solving for a again gives the corrected radius as 

 ( )
2

d u
b b 9a v v

2p 2p 4g
⎛ ⎞ η

= − + + −⎜ ⎟ ρ⎝ ⎠
. (6) 

This value of a can be used to compute the mass of the droplet, and thus the charge directly from 
Eq. (3).  By observing several droplets and measuring vd and vu, you will compute their charges 
and look for evidence of a fundamental charge unit. 
 

Procedure.  You will need the following (FB = front bench only): 
 

• Millikan oil drop apparatus (FB) • VideoFlex camera with adapters (FB) 
• 0-500 V voltage supply w/readout (FB) • Video projector (FB) 
• digital multimeter (FB) • Computer with video analysis software 
• Stopwatches (2)  

 

                                                 
4 Note that here, vu and vd are speeds, and are hence positive quantities. 
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Each group should take data on droplets from the apparatus and from the videos on the 
laptops: 

 
I. Taking data from the apparatus: (Each group takes data on one droplet.) 
 
The oil drop apparatus should already be set up and optically aligned, so there is no need 

to make any adjustments, except as indicated by the instructor. 
 
1. Determine the temperature T of the droplet viewing chamber (for the calculation of η) 

from the resistance of the thermistor and the thermistor resistance table at the very end of this 
write-up.  You will need to linearly interpolate since the measured resistance is unlikely to be 
one of the table entries.  Alternatively, you can input this resistance in the worksheet (see below 
under “Analysis”) and let it calculate T. 

 
2. Measure and record the voltage V at the input terminals of the plates. 
 
3. Move the ionization source lever to the “Spray Droplet” position and eject a spray of 

oil droplets from the atomizer into the chamber with one quick squeeze followed by a slow 
squeeze.  When the droplets appear in the viewing field, switch the source lever to “OFF.” 

 
4. Select a droplet that can be made to rise and fall depending on the polarity of the plate 

voltage, as controlled by the 3-position plate voltage switch.  Noting that the vertical distance 
between major reticle lines is 0.5 mm, time the motion of this droplet with the polarity such that 
the droplet moves downward and calculate vd.  Switch the voltage polarity so that the droplet 
rises, and measure vu by timing this upward motion.  Make a note of which polarities cause the 
drop to rise/fall and so deduce the sign of its charge. 

 
Repeat these measurements two more times for this droplet, if possible, to produce a total 

of at least three pairs of speeds vd and vu.  For each pair of speeds you can produce a value of the 
charge q on the droplet (see below under “Analysis”).  Averaging these values for a single 
droplet gives the best value q  of its charge; calculating the standard deviation (the “spread”) of 
these values gives an estimate of the uncertainty associated with q.  Recall that the uncertainty in 
q  is smaller than that in q (see “Uncertainties” below).  You can also estimate the uncertainties 
from the worksheet. 

 
You can attempt to change the charge on this droplet by moving the ionization source 

lever to the ON position (with the E-field off) for a few seconds; if the velocity with E back on 
has changed, make a new set of measurements to determine the new charge.  As time permits, 
measure the terminal speeds for additional droplets in various charge states. 

 
Post your group’s average values for the down and up speeds ( dv and uv ) for your drop 

along with the chamber temperature (T) and plate voltage (V) in a table on the board (like the 
one below) to share with the class: 
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Group # fv  (m/s) rv  (m/s) T (°C) V (V) 

1     
2     
3     
4     
5     
6     

 
 
 II. Taking data from the videos: (Each group analyzes three droplet videos.) 
 
In the folder “Millikan Oil Drop Videos” on your desktop you will find a series of 

QuickTime videos shot using the Oil Drop Apparatus that can be analyzed in the same way as 
the observations you made at the front bench.  Make measurements on three different charges, 
obtaining the up and down speeds for each one. 

 
You can use the dvvpcap program to observe droplet positions and the corresponding 

timecodes for individual frames. From this you can estimate droplet speeds.  To use dvvpcap, 
bring it up from the desktop and click OK/OK/NO and select the droplet movie to analyze. 

 
Alternatively, the VideoPoint software, also available from the desktop, will allow you to 

import the movie and chart the vertical coordinate vs. time.  Note that is better to tabulate a few 
widely spaced values of y and t over the entire range of vertical motion rather than a few points 
spaced one frame apart (why?).  When these (t,y) points are graphed, the slope will yield an 
accurate speed (vu or vd) for the droplet.  You can also transfer data from VideoPoint to Logger 
Pro, although problems with the clipboard have been reported.  But Logger Pro has the 
advantage of giving the uncertainties as well (Analyze→Curve fit). 

 
Analysis.  Compute a value of the charge q , as described below, for each of the droplets 

observed by the lab groups using the apparatus, as well as for any three droplets featured on the 
videos.  A Mathcad file entitled “Millikan Oil Drop Worksheet.mcd” can be found in the 
Dietz’s 204B LABS\Millikan Oil Drop folder accessible from the desktop.  This is a worksheet 
in which you can fill in the data for the computation of the droplet charge, which appears at the 
bottom of the sheet5. 

 
Note: It is recommended that q ± Δq for each droplet be calculated and recorded before 

moving on to take data for the next droplet.  That way you’ll have some charge values at the end 
even if you don’t have time to finish calculations on all of the selected droplets. 

 

                                                 
5 If you find the speeds using the VideoPoint or Logger Pro graphical analysis tools, 
you can enter these results directly into the worksheet (instead of times and 
distances) by overriding the definitions of the speeds. 

EDietz
Text Box
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For each charge state of each of the droplets you observed, you can use Eq. (3) to 
determine its charge q (don’t forget the sign).  To do this, however, you will need to know (in 
addition to the average terminal speeds): 
 
(a) The radius a of the droplet (to get the mass): This can be calculated from Eq. (6), where 
 

1. The atmospheric pressure p is in Pascal (Pa) and 1 Pa = 1 N/m2.  Note that 
1 atmosphere (atm) is 760 mm Hg = 1.013 × 105 N/m2, so 1 atm is 1.013 × 105 Pa.  
The pressure in the room should be around 1 atm, depending on atmospheric 
conditions.  Read p from the barometer mounted on the west wall of the lab room and 
convert to Pa. 

 
2. The viscosity η  of the air inside the viewing chamber.  This is a function of the 

temperature, given as ( ) ( )3 5 2(T) 1.729 4.765 10 T 10 Nsm− − −⎡ ⎤= + × ×⎣ ⎦η , where T is in 
°C as determined from the thermistor reading using the chart (with interpolation) at the 
very end of this write-up (or with the numerical fit from the worksheet). 

 
3. The constant b, used to correct the viscosity for the smallness of our droplets, is given 

as 3b 8.20 10 Pa m−= × ⋅ . 
 
4. The density of the mineral oil, given as ρ = 886 kg/m3. 
 

(b) The mass m of the droplet, calculated from 34m a
3

= π ρ . 

 
(c) The electric field E between the plates (in N/C or V/m).  This is calculated from the plate 

voltage V using VE
d

= , where d is the plate separation, measured as 7.60 × 10−3 m for our 

apparatus. 
 
 Note that the above calculations can be done manually or by filling in values on the 
worksheet. 
 
Finally: 
 
 (1)  Tabulate the charges you calculated for the droplets (with estimated uncertainties) 
and look for regularities, i.e., are the charges multiples of some unit, say the smallest difference 
between charges? 
 
 (2)  Assuming these charges are in fact integer multiples of the elementary charge e, 
determine the number of elementary charges on each drop, along with the value of e derived 
from this assessment (include uncertainties).  What is the average value of e from all the drops 
that you observed? 
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 Uncertainties.  One way to estimate the uncertainty in any charge measurement is to 
look at the “spread” (the standard deviation qΔ ) of several measurements of the same charge q.  
Since you are averaging these values, the uncertainty in an average charge q can be estimated as 

qq
n

Δ
Δ , where n is the number of charges averaged.  To get an idea of the fractional 

uncertainty q
q

⎛ ⎞Δ
⎜ ⎟
⎝ ⎠

 for these measurements, each group should compute qΔ  for the charges 

calculated from the sets of (vd, vu) data for the droplet they observed on the apparatus. 
 
 Note that the worksheet will also compute the uncertainty in a single charge from the 
estimated uncertainties in the experimental parameters, which you must provide.  Uncertainties 
in parameters given to you as data in the movie (e.g. pressure p), you can make estimates based 
on the number of significant figures presented. 
 
 Conclusion. Report your best estimate (with uncertainties) of the value of the elementary 
charge.  Is this within uncertainties of the accepted value of e? 
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Appendix: 
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Electric Potential and Electric Field 
 

 Introduction.  If a set of conductors is maintained 
at a fixed potential difference by a battery (or power 
supply), an electric field is created in the surrounding 
region by the charge that the battery deposits on them.  In 
the configuration shown at the right, for example, the 
battery (which provides a voltage V0) maintains the 
conductors at potentials V0 and 0. 
 
 The value of the potential V for each point in the 
region of the conductors depends on the details of how the 
charge is distributed on them.  This in turn depends on the 
size, shape and positioning of the conductors, along with V0. One way to represent the resulting 
pattern is to draw equipotential lines--lines of constant potential--and label them with the 
corresponding voltages (Vi) as shown above.  The lines representing the electric field may then 
be drawn perpendicular to these equipotentials.  It is sometimes important to know the 
equipotential and field patterns associated with various electrode configurations (for example, in 
the design of ion optics).  Unfortunately, patterns for all but the simplest of electrode 
arrangements are quite difficult to compute.  In this exercise you will learn a technique which 
utilizes resistive (Teledeltos) paper to construct equipotential lines.  In addition you will see how 
well the measured pattern of potentials for concentric cylinders agrees with the prediction of 
Gauss’s law. 
 

Procedure.  You will need the following: 
 

• Teledeltos apparatus • Laptop with Logger Pro 
• low voltage power supply • dipole and cylinder electrodes 
• digital multimeter • cables/alligator clips/pointed electrodes 
• Vernier calipers and cm ruler • French curve 

 
1. Dipole Pattern (Qualitative): Arrange the 

board, plastic sheet, data page, carbon paper and 
resistive paper as shown at the right.  Tightly screw 
the dipole electrodes to the assembly so that the 
grooved sides make contact with the resistive paper. 

 
Connect the leads from the DC supply to each 
electrode and connect the common side (“COM”) of the digital multimeter (DMM) to the 
negative terminal of the supply.  The other side of the DMM is the “probe,” (plugged into the 
“V” socket).  If connected correctly, the DMM (configured to read voltage) should read zero 
volts when the probe is touched to one of the electrodes and the full supply voltage V0 when in 

V0 V

probe

plastic sheet
boarddata page

carbon paper
resistive paper

electrodes
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contact with the other.  Mark the location, polarity and voltage of the electrodes on the data page 
by pressing down firmly on the resistive paper with the probe. 
 
With V0 adjusted to some convenient value, which you should record, gently slide the probe 
(without the alligator clip) over the surface of the resistive paper and observe the output of the 
voltmeter.  Locate the point at a voltage V = V0/2 between the dipole electrodes, and continue to 
find points at this potential on your sheet.  Repeat this for four more values of V, so that you 
have points for five equipotentials corresponding to five uniformly spaced values of V between 0 
and V0 (be sure to distinguish points corresponding to different values of V as you mark them).  
Remove the data page and sketch your equipotential lines for the dipole and label them with 
voltage values.  Noting that the lines of electric field are everywhere perpendicular to the 
equipotential lines, sketch the lines of the E-field (include directions).  Sketch and label both sets 
of lines in your notebook. 
 
 2. Concentric Cylinders (Quantitative): 
Arrange the apparatus as shown at the right with 
the ring and the small disk attached 
concentrically. Tighten the electrodes securely 
with screws and wing nuts through each hole.  
Measure the outer diameter of the inner electrode 
and the inner diameter of the outer electrode.  
Record the respective radii a and b. 
 
 Set the power supply to V0 = 15.0 V.  Move the probe along three different radii (about 
equally spaced in angle) until you locate the point where V = 10.0 V on each radius; pressing 
down with the probe will record these positions on the data sheet.  Repeat this for V = 7.50 V, 
5.00 V, 3.00 V, 2.00 V, and 1.00 V.  Make sure you keep track of the potential for each point. 
 
 Use a pencil to outline the positions of the inner and outer electrodes, and remove the 
data page.  Tabulate the average values of r, the distance from the center, corresponding to each 
of the potentials. 
 
 Theory: Due to the constraints imposed by the resistive paper, this pattern of potentials 
corresponds to that of two very long concentric cylinders with radii a and b, rather than that of 
two circles.  For the cylinders, the electric field in the region between them points radially 
outward; Gauss’s law predicts that the field strength diminishes with r, the distance from the 
axis, and is given by 

 
0

E
2 r
λ

=
π ε

, (1) 

where λ is the linear charge density on the inner cylinder.  The difference between the potential 
of the center conductor (V0) and the potential V(r) at a distance r from the axis is found by 
integrating this expression for E along a radius: 

V0 V

probe
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r

0 r 0 a
0

aV V(r) V d ln
2 r→
λ

Δ ≡ − = − ⋅ =
πε∫ E l . (2) 

If we put ground (V = 0) at the outer electrode (r = b), then setting V(b) = 0 in Eq. (2) gives us λ 
for this situation, which can the be substituted back into the same equation to give V(r): 
 

 
( )
( )0

ln b r
V(r) V

ln b a
= . (3) 

 
(Be certain you know how to obtain this result for V(r)!) 
 
 Analysis.  In Logger Pro, tabulate and graph V/V0 (on the y-axis) vs. ( )ln b r  (on the 
x-axis).  Find the best fit line and determine if the slope is within uncertainties6 of what you 
would expect from Eq.(3), which was derived from Gauss’s law.  Sketch this graph in your 
notebook. 
 
 Conclusion.  Are the equipotential and E-field lines that you sketched for the dipole 
arrangement approximately consistent with what you expected from your knowledge of 
Coulomb’s law applied to + and − point charges?  To what three-dimensional configuration does 
this resistive paper pattern actually correspond? 
 

                                                 
6 In Logger Pro, you can obtain the uncertainty in the slope of the best-fit line by 
double-clicking the fit box and checking the box for the standard deviation in the 
slope. 
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Capacitors and Charge 
 

 Introduction.  A device that acquires a charge in response to the application of a 
potential difference across its terminals has a property we call capacitance.  Capacitors are 
important components in electronic devices that perform functions such as timing, tuning, 
filtering, energy storage and sensing. In this set of experiments you will determine how the 
capacitance of a set of parallel plates depends on their separation and on the material in the space 
between them.  You will also use capacitors to see if charge is conserved. 
 
 For two conductors, we define the capacitance C as the number of Coulombs of charge Q 
that it “holds” (i.e., its capacity) per unit of applied potential (V): 
 Q CV≡  (1) 
There are only a few configurations of conductors for which this property is readily computed 
from the geometry.  As has been (or soon will be) discussed in class, the parallel plate 
arrangement has a capacitance given by 

 0
AC K
d

= ε . (2) 

 
Procedure.  You will need the following: 
 

• laptop • 2 (good) electrolytic capacitors 
• low voltage DC power supply • Vernier calipers and cm ruler 
• cables and alligator clips • PASCO variable capacitor 
• Sencore LC103 Capacitor & Inductor 

Analyzer 
• Sencore Analyzer 

• Fluke 179 digital multimeter (DMM) • cold pack 
 

 I. Dependence of capacitance on plate separation: 
  
 Set up the LC103 “ReZolver” to measure capacitance7: Connect and zero the test leads 
(see p. 1 in the pull-out instructions) and press “all other caps” under “Component Type.”  
Connect your capacitor (the set of circular parallel plates on the plastic track) to the test leads 
(use alligator clips); press and hold the “Capacitor Value” button to read C (p. 4, part 1).   
 Slide one of the plates along the track to get different plate separations8 d (indicated on 
the scale) and measure the capacitance C with the analyzer for each value of d.  Take 10 data 
points (values of C and d) and tabulate the data in your notebook.  Open the Dependence of C 
file in the “Dietz’s 204B LABS\Capacitors and Charge” folder and plot C vs. d.  What function 

                                                 
7 Never connect a battery or power supply to a device while it’s connected to the 
Sencore analyzer!  The Sencore has its own internal power supply.  Always discharge 
the capacitor before connecting it to the analyzer! 
8 Keep the value of d small compared to the linear dimension (diameter) of the plates. 
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gives the best fit for the data?  Is this consistent with the prediction of Eq. (2)?  Sketch the best-
fit curve in your notebook. 
 Set the plate separation at a value equal to the thickness of the “cold pack” provided.  
Measure and record the capacitance both without and with the cold pack inserted between the 
plates.  What can you conclude about the effective dielectric constant of the material inside the 
pack? 
 
 II. Capacitors and Charge Conservation: For each of two electrolytic capacitors (C1 and 
C2), measure the capacitance and the leakage resistance as follows: 
1. Select the component type: “Aluminum Lytics.” 
2. Enter the operating voltage, i.e., the maximum voltage4 you will apply during the 

measurements described below (p. 2, part 4 in pull chart instructions near the bottom of the 
unit.). 

3. Read and record C as in part I above (red test clip to +).  Note the uncertainty ΔC from 
Appendix B. 

4. Perform the leakage test (p. 4, part 4) and record the leakage resistance RL--this is the effective 
resistance in parallel with the capacitor; the smaller RL, the faster it looses its charge. If you 
calculate the time τC = RLC, this will give you an idea of the time scale on which the capacitor 
will spontaneously discharge--and how fast you must work in performing the measurements 
that follow9. 

 
(a) Discharge each capacitor by shorting the 
terminals with a cable.  Using the circuit at the 
right in (a1), charge C1 and record the voltage10 
V1 ± ΔV1 read on the DMM (see Appendix B 
for uncertainties).  Be sure to observe the 
polarities!  Disconnect C1 from the supply11 and 
connect C1 and C2 as shown in (a2) and measure 
the common voltage V V′ ′± Δ . 
 
Predict: How will the charges q1, 1q′ , and 2q′  be 
related? 
 

                                                 
9 Circuit Tips: 1. Before measuring component values with a meter, always remove the 
component from the circuit.  2. Lay out the components physically as they appear in 
the circuit diagram, then interconnect with cables.  3. Connect the “main” circuit 
first and the meters and/or scope last. 
10 Do not exceed the voltage rating on the side of the can. 
11 For both parts (a) and (b), it is important to disconnect the capacitor(s) from the 
supply before turning it off (to prevent charge leakage through the supply). 
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V1

(a1)

(a2)
C2

q
1

q
1

q
2 V

 



Capacitors and Charge Physics 204B Laboratory 
 

 21 
 

Use Eq. (1) to calculate the initial charge q1 on C1 and the final charges 1q′  and 2q′  on C1 and C2 
respectively, along with the uncertainties (see below). 
 
 
 
 
(b) Short out the two capacitors again and connect them 
with the power supply as shown in (b1) at the right.  
Measure the voltage V1 ± ΔV1 and then V2 ± ΔV2.  
Disconnect the capacitors from the power supply and then 
reconnect them as in (b2) (observe polarities!).  Measure the 
new voltage V V′ ′± Δ . 
 
Predict: What relationship do you expect to discover 
between the charges q1, q2, 1q′and 2q′ ?  Are q1 and q2 related? 
How? 
Compute all the charges q1, q2, 1q′and 2q′ , along with their 
uncertainties. 
 
 
 
 Uncertainties. The uncertainties for the capacitances measured by the LC103 ReZolver 
can be determined from Appendix B, as can the uncertainties for all the voltages measured with 
the Fluke 179. 
 
 For the charges, note that Eq. (1) implies, by way of Eq. (8b) in Appendix A, that their 
uncertainties are approximated as 

 
2 2q C V

q C V
Δ Δ Δ⎛ ⎞ ⎛ ⎞= +⎜ ⎟ ⎜ ⎟

⎝ ⎠ ⎝ ⎠
. (3) 

Also note that every time you add two quantities that each have an uncertainty, you compound 
the uncertainty for the sum as per Eq. (8a) of Appendix A.  Thus the uncertainty in the sum 
(qSUM) of two charges q1 and q2 would be given as 

 ( ) ( )2 2
SUM 1 2q q qΔ = Δ + Δ . (4) 

 
 It is seldom necessary or desirable to keep more than one significant figure for the 
uncertainty in a final result. 
 
 Analysis. From your measurements in part II, determine whether your predictions for the 
relationships among the charges in each of the two experiments were confirmed, within 
uncertainties. 
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 Conclusion.  What did you learn about capacitors in Part I?  In particular, how does the 
capacitance of the parallel plate arrangement depend on its dimensions and on what’s in between 
the plates, according to your investigation? 
 
 What do you conclude about charge conservation from your work in Part II?  Are there 
uncertainties or systematic errors for which you have not accounted? 
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Ohm’s Law 
 

 Introduction.  The application of a potential difference (voltage) between two points on 
a conductor will cause a current to flow.  If this current (I) is directly proportional to the voltage 
(V), then the conductor is said to obey “Ohm’s Law:” 
    
 V IR= . (1) 
 
The constant of proportionality, R, between V and I is the resistance of the object and has units 
of Ohms (Ω).  Conducting objects for which this law holds for over a range of conditions (e.g., 
temperature) are referred to as “Ohmic devices12” (e.g., resistors, wires). 
 
 In this lab, you will investigate the relationship between V and I for a resistor and for a 
light bulb and see if Ohm’s law is obeyed. 
 

Procedure.  You will need the following: 
 

• Laptop with LabPro interface • 10 Ω and 50 Ω resistor 
• current probe • light bulb (6.3 V) and holder 
• French curve • multimeter 
• differential voltage sensor (for LabPro) • wires and clips 
• DC power supply  

 
 Boot up the laptop and connect the LabPro to DC power with the adapter and to the 
laptop with the USB cable.  Connect the Current Probe (CP) and the Differential Voltage Sensor 
(DVS) to Chs. 1 and 2 of the LabPro, respectively, as shown below.   
 
 
 
 
 
  
 
 
 
 
 

I. Voltage vs. Current for a resistor: Set up the circuit with the power supply (OFF 
initially!) and the resistor with the Current Probe (CP) in the circuit as indicated above (note the 

                                                 
12 The resistance can be defined as 

V
R

I
≡  even for non-Ohmic devices, but for these, 

R is not constant as V is changed. 
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+ direction of the current flow as indicated by the arrow on the CP).  Clip the DVS leads across 
the resistor.  Turn the voltage knob on the power supply fully counterclockwise and the current 
knob (current limit control) fully clockwise. 

  
 Run Logger Pro and open the Ohm’s Law file (File→Open) in the “Dietz’s 204B 
LABS” folder.  With the power supply off and disconnected and the leads to the DVS shorted, 
use the zero ( 0 ) button (3rd from the right on the toolbar) to set the zero for V and I.  Turn the 
power supply on and click on the “collect” button (2nd from the right on the toolbar) to begin 
taking data.  Slowly begin increasing the voltage (do not exceed 6.0 V!) and note the increase in 
V and I values on the “meter” at the lower left.  After the values of voltage and current have 
stabilized, click on the rightmost button on the toolbar to “keep (the) current value” as a data 
point.  Take several data points for the resistor and when finished click “stop” (in same position 
as “collect”). 
 
NOTE: Turn off the power supply when not in use. 
 
 Analysis. Determine the best-fit line for your V vs. I data: sort the I values in ascending 
order using the data menu, the use Analyze→Automatic Curve Fit.  Sketch the graph in your 
notebook.  Record the slope with its uncertainty and write an equation for V as a function of I 
(include units). 
 
 Take the resistor out of the circuit and measure its resistance with the digital multimeter 
(DMM), noting the uncertainty (Appendix B).  Compare this value with the slope of your V vs. I 
line. Finally, compare these two resistance values with the value indicated on the resistor body13. 
Are these three values of the resistance consistent with each other, within uncertainties? 
 
 II. Voltage vs. Current for the light bulb: Clear the resistor data (Data→Clear All Data) 
and replace the resistor in the circuit with the light bulb.  Again, use Logger Pro to collect and 
analyze the V vs. I data for V between 0 and 6 V (try to get several data points in the range 
between 0 and about 0.4 V). 
 
Predict: What will be the resistance of the bulb as measured by the DMM? 
 
Test your prediction by removing the bulb from the circuit and measuring its resistance with the 
DMM.  Comment on the result in light of your prediction. 
 
                                                 
13 The uncertainty in the resistor value printed on the body is given by the tolerance 
code.  If there are colored bands on the body, then the value of R and its uncertainty 
are given in Appendix C.  The letters “J” and “K” indicate 5% and 10% uncertainties 
respectively. 
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 Analysis. Is the relationship between V and I for the bulb a linear one?  Use 
Analyze→Curve Fit to find a function that gives a relationship V(I) that fits your data.  Sketch 
the graph. 
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Resistor Circuits 
 

 Introduction.  In this set of exercises, you will investigate several tools (or rules) that 
can be applied to the analysis of even very complex circuits.  Rules for dealing with resistor 
combinations are often quite useful, as are the 
more generally applicable Kirchhoff’s circuit 
rules. 
 
 Several resistors can be wired in series to 
increase their effective length and in parallel to 
increase their effective cross-sectional area, as 
shown at the right.  For resistors in series, the total 
equivalent resistance (ratio of V to I) is given as 
 s,eq i

i

R R= ∑ . (1) 

For resistors wired in parallel, the equivalent resistance is found from 

 
ip,eq i

1 1
R R

= ∑ . (2) 

 It is often the case that even many simple circuits with only batteries and resistors cannot 
be analyzed with just the series and parallel combination rules.  For these we need the power and 
generality of Kirchhoff’s circuit rules: 
 
1. Voltage Rule (KVL): The sum of the voltage changes (drops or rises) taken around any loop in 
the circuit is zero, i.e., 
 i

i

V 0Δ =∑ . (3) 

2. Current Rule (KCL): The sum of all currents into (or out of) any junction is zero, i.e., 
 i

i

I 0=∑ . (4) 

 
 Procedure.  You will need the following: 

 
• Resistors, 10 Ω and 50 Ω (3 ea.) • Fluke DMM 
• Cables (of various lengths) and clips • light bulb (6.3V) and holder 
• batteries and holders to make 3V and 

6V sources 
 

 
I. Resistor Combinations: Measure the resistances of all of your resistors using the DMM 

configured as an ohmmeter; record the uncertainties (Appendix B) as well.  Make sure to keep 
track of which values go with which resistors. 
 
(a) Series combination: Connect two resistances in series as in Fig. (a) above. 
  



Resistor Circuits Physics 204B Laboratory 
 

 27 
 

Predict: What will be the series resistance, predicted from the combination rules above?  Include 
an uncertainty (Appendix A, Eq. 8(a)). 
 
Now use the DMM to measure the series resistance and note the uncertainty.  Is your result 
consistent with the combination rule for series resistances? 
 
(b) Parallel combination: Connect two resistances in parallel (Fig. (b) above). 
  
Predict: What will be the equivalent resistance of this combination? 
 
Again, test your prediction with the DMM and compare. 
 
(c) Construct the resistor combination shown below, using your two different values for R1 and 
R2. 
 
 
  
 
 
 
 
 
 
 
Predict: What will be the equivalent resistance between points A and B? 
 
Use the DMM to measure this resistance, and compare with your prediction. 
 
(d) Construct the circuit shown at the right with R1 = 10 Ω and 
R2 = 50 Ω.  The bulb should glow. 
 
Predict: What will happen to the brightness of the bulb when 
you 
(i) short out R2 on the right by connecting a cable across its 
ends? 
(ii) disconnect R1 from the parallel combination? 
(iii) short out the parallel combination? 
 
Try each of these actions, returning the circuit to the original condition after each one.  Did any 
of the results surprise you? 
 
NOTE: For all experiments using batteries: Please disconnect them when not in use! 
 

Bulb
6V

R1

R2

R2
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II. Kirchhoff’s Laws: Construct the circuit below using ε1 = 3 V, ε2 = 6 V, and any combination 
of values for R1, R2, and R3.  Sketch the circuit with the values.  Note that the combination rules 
for series and parallel resistances cannot be applied directly here to give the currents flowing in 
the wires. 
 
 
 
 
 
 
 
 
 
 
Note: Remember to 
disconnect the batteries from the circuit when not making measurements! 
 
1. Voltage Rule: Set up the DMM to measure DC voltage (potential difference).  Go around 
Loop 1, measuring and recording the potential difference across each element, carefully noting 
the polarity and the uncertainty for each.  Write the values and indicate the polarities on your 
sketch. 
 
Note: Differences in potential are measured in parallel as shown at the right—
across the element (a resistor in this case).  The reading will represent the change 
in potential from the “COM” input to the “V” (+) input.  In the case shown, the 
reading will be positive if current flows to the right through the resistor. 
 
Repeat these voltage measurements for Loop 2. 
 
Are your measurements consistent with the Voltage Rule (KVL), within uncertainties? 
 
2. Current Rule: Set up the DMM to measure DC current14.  Measure all the currents flowing 
into Junction 1, carefully noting directions (see note below) and uncertainties.  Record the values 
and directions on your sketch. 
 
Note: Currents are measured in series as shown at the right; you will need to “break” 
the circuit to insert the ammeter.  The reading represents the current flowing into the 
“mA” input (towards the “COM” connection point).  For the connection shown, the 
meter will display a positive number if the current flows to the right (into the mA 
socket).  Caution: Never connect the meter across an element (as in the voltage 
measurement above) while it is set up to measure current! 
 

                                                 
14 If necessary, press the yellow button until the “DC” indication appears on the 
display. 
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Repeat these current measurements for Junction 2. 
 
Are your measurements consistent with the Current Rule (KCL) to within uncertainties? 
 
 Uncertainties. In Appendix A, Eq. (8) and, in particular, Eq. 8(a) for sums, offer some 
guidance in estimating uncertainties for predicted values of resistances derived from formulas for 
their combination, if the individual ΔR’s are estimated from Appendix B. 
 

For the series equivalent of two resistances: ( ) ( )2 2
s 1 2R R RΔ = Δ + Δ . 

For the parallel equivalent, the uncertainty in the reciprocal of Rp, is given by 
2 2

p 1 2

1 1 1
R R R

⎛ ⎞ ⎡ ⎤ ⎡ ⎤⎛ ⎞ ⎛ ⎞
Δ = Δ + Δ⎜ ⎟ ⎢ ⎥ ⎢ ⎥⎜ ⎟ ⎜ ⎟⎜ ⎟ ⎝ ⎠ ⎝ ⎠⎣ ⎦ ⎣ ⎦⎝ ⎠

.  The uncertainty in each of these reciprocals is 

2

1 R
R R

Δ⎛ ⎞Δ⎜ ⎟
⎝ ⎠

, which can be substituted for each of the three terms above to find pRΔ .  (The 

alternative is to grind through the derivatives in Eq. (8).) 
 
  Eq. 8(a) will also be useful in estimating the uncertainties in the sums involved in KVL and 
KCL. 
 
 Remember to resist the temptation to keep more than one significant figure for the final 
uncertainty in any reported quantity. 
  
  
 Conclusion.  Do the rules for series and parallel combinations of resistors appear to be 
valid?  Did the light bulb exercise serve to make them clearer conceptually? 
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RC Circuits 
 

 Introduction.  In this set of investigations we will explore the behavior with time of the 
charge on the plates of a capacitor as it charges and discharges through a resistance.  As an 
interesting timing application for capacitors, you will also construct and investigate a relaxation 
oscillator (flasher). 
 
 When Kirchhoff’s voltage rule was applied to a capacitance (C) and a resistance (R) in 
series, we found that the voltage across the capacitor as it discharges through the resistor is given 
by 
 C

0
tV V e− τ= , (1) 

where V0 is the voltage at t = 0 and C RCτ ≡  is called the capacitive time constant for the RC 
combination; this constant sets the time scale on which the discharge occurs. 
 
 A similar analysis for the charging process, in which a battery or other source of emf (V0) is 
placed in series with R and C, shows that the voltage is given by 
 ( )C

0
tV V 1 e− τ= −  (2) 

if it is zero at t = 0.  In this case the voltage approaches that of the battery asymptotically as the 
charging proceeds. 
 
 Procedure.  You will need the following: 

 
• Laptop with LabPro interface • Battery holder and batteries for 6V source 
• current probe • bulb (6.3V) and socket 
• neon lamp • 18000 μF capacitance 
• differential voltage sensor • wires, alligator clips, spade lugs 
• SPDT switch • 100−Ω resistor 
• Digital multimeter • 90 V battery source 
• stopwatch • two 1 MΩ resistors 
• two 1 μF capacitors (250 V) • Sencore LC103 Capacitor & Inductor Analyzer 

 
I. Charging and Discharging (qualitative investigation): Connect the switch, the 6.3 V 

light bulb, the large capacitor, and the 6 V source as in the circuit at the below: 
 
 
 
 
 
 
 
 
Predict: What will be the behavior of the 

+ -

6V

C

1

2

bulbsingle pole
double throw
switch
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brightness of the bulb vs. time when the switch is moved to position 1 (charge) and then after a 
while is moved to position 2 (discharge)? 
 
1. Move the switch to the discharge position (2) to drain any residual charge from the capacitor.  
After at least 30 s, switch it to the charging position (1) and describe what happens to the 
brightness of the bulb.  Make a sketch of approximate brightness vs. time in your notebook. 
 
2. After the switch has been in the charging position for a while, move it back to discharge C.  
Again, describe what happens to the brightness of the bulb and sketch a brightness vs. time curve 
for this process. 
 
Try to explain your observation in terms of the charge on the capacitor and its motion (i.e., the 
current) in the circuit. 
 
 II. Charging and Discharging (quantitative investigation): Since (as you discovered in the 
Ohm’s law investigation) the resistance of the bulb does not remain constant with varying 
current, we will replace it with a 100−Ω resistor to do a careful quantitative investigation of how 
the charge and current vary with time in your capacitor circuit. 
 
 Use the DMM to measure R ± ΔR for a 100−Ω resistor and the Sencore analyzer to 
measure C ± ΔC for the capacitor15 you used in the bulb observation above.  Use these elements 
to construct the circuit below: 
 
 
  

 
 
  
 
 
 
 
Connect the current probe in series with R and C with the arrow as indicated to measure the 
capacitor current (dQ/dt); clip the differential voltage probe (DVS) across the capacitor terminals 
to measure capacitor voltage (proportional to the charge Q on the plates). 
 
 Connect the current probe (CP) and the Differential Voltage Sensor (DVS) to Chs. 1 
and 2, respectively, of the LabPro.  Bring up Logger Pro on the laptop and open up the file 
Charging and Discharging.  Zero both probes and move the switch to position 2 to discharge 
the capacitor.  Begin collecting data and move the switch to position 1.  When the current and 
voltage stop changing, move the switch back to position 2.  Sketch the current vs. time and the 
voltage vs. time curves in your notebook for both the charging and discharging processes. 

                                                 
15 Always discharge the capacitor before connecting it to the analyzer! 
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 Analysis: 
 
 1. Discharge: Use the Analyze→Examine cursor to determine the time interval between  
the closing of the switch to position 2 and the reduction of the charge (or the voltage) on the 
capacitor to 37% of its maximum value obtained when the switch was in position 1.  (Another 
way to look at it: how long does it take for 63% of the change to occur when the switch is 
moved?)  Estimate an uncertainty based on how closely you can read the graph. 
 
 Select the portion of the V vs. t discharge curve where the voltage is changing and try to 
fit a curve with the form of Eq. (1) above to the data (Analyze→Curve Fit).  Note: you will most 
likely need to “define function” and enter “ 0t t− ” instead of just “t”, since the discharge doesn’t 
start at t = 0 on your graph, as assumed by Eq. (1).  Comment on the quality of the fit and 
whether this indicates that the process is exponential.  Note the value of τC for your fit, along 
with the uncertainty. 
 Compare the three values of your time constant τC: (a) from the component values, 

C RCτ = ; (b) from the value of “t” at 63% of the way down on the discharge curve; and (c) from 
the exponential curve fit.  Are all these values consistent, considering uncertainties? 
 
 2. Charge: Repeat the analysis for the charging (beginning) portion of the V vs. t curve, 
comparing the three values of τC from the component values, the 63% point and the fit to Eq. (2). 
If this value is different from that obtained for the charging process, can you think of a reason? 
 
 III: Flasher (Relaxation Oscillator): Construct the circuit below with C = 1 μF and 
R = 1 MΩ.  Measure C and R and record the values. 
 
Caution: When building this circuit, make connections to the battery last.  Disconnect the 
battery first when changing or dismantling the circuit.  Avoid contact with both battery terminals 
simultaneously. 
 
  
 
 
 
 
 The neon bulb has the property that when the voltage applied between its terminals 
exceeds a certain value (the threshold voltage), the gas in the bulb breaks down and conducts 
current. 
 
 When the connections are completed and the button pressed, the neon bulb should flash 
periodically16.  From your knowledge of RC circuits and the behavior of the bulb, sketch a curve 

                                                 
16 If the bulb doesn’t flash, try reversing the polarity of its leads. 
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R

C neon
bulb

 



RC Circuits 

 33 
 

that you think represents the voltage across C vs. time.  With your stopwatch, measure the time 
interval T between flashes (average over several intervals!). 
 
 
Predict: What will be the new value of T when C is replaced by two 1-μF capacitors in series?  
What assumptions are you making with this prediction? 
 
 Make this change (again, disconnect the battery when working on this circuit!).  Measure 
the new time interval between flashes.  How was your prediction? 
  
 Uncertainties.  Meter uncertainties for R and C are in Appendix B.  Eq. 8(b) will help 
you deal with uncertainties in the RC time constant. 
  
 Conclusion.  Do your observations indicate that charging and discharging a capacitor 
through a resistance is an exponential process?  Are your results in quantitative agreement with 
Eqs. (1) and (2) above? 
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The Charge-to-Mass Ratio of the Electron 
 
 
Introduction.  In 1897, J. J. Thomson, renowned physicist, 
performed an experiment which established the electron as a 
fundamental particle and measured the ratio of its charge (e) to its 
mass (m).  Using a variation of his technique, you will do a 
measurement of e/m by observing the trajectory of speeding 
electrons as they are deflected by a magnetic field. 
 
 The apparatus for the observation of electron trajectories is 
pictured schematically below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Electrons are boiled off a heated cathode and accelerated through a potential difference V.  They 
emerge from the exit aperture of the electron gun housing (the anode) in the presence of a 
magnetic field B and are thus deflected into a circular arc of radius R; this arc is made visible by 
electron's impact against a fluorescent grid.  The radius R can be related to the electron mass m, 
its charge e, the electron speed v, and the field strength B by writing FM = ma = mv2/R, where FM 
is the magnetic deflecting force of magnitude evB.  The ratio e/m is then given as 
 

 
 
We can therefore calculate e/m from the measured value of R if we know v.  By conservation of 
energy, the speed with which the electrons emerge from the gun is related to the accelerating 
voltage V: ½mv2 = Ve, so that v is given by 

 

 e
m

 =  v
RB

 (1)
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Combining Eqs. (1) and (2) allows us to solve for e/m in terms of measurable quantities: 
  

 2 2

e 2V
m B R
=  (3) 

 
 
The quantities V, R, and B will be measured using your apparatus: 
 
1. The radius R is measured by recording the coordinates (x, y) of some point on the arc as 

far as possible from the exit aperture.  Since the electron beam emerges horizontally from 
the anode, located at the origin of the coordinate grid, the radius is given in terms of x 
and y as 

 

 
 
2. The magnetic field B is created by a pair of  “Helmholtz coils,” and is nearly uniform in 

the region of the electron beam.  Its magnitude in Teslas can be calculated from the 
measured current I in the coils: 

 

 
3. The accelerating voltage V is read directly from the meter (top scale) on the high voltage 

supply. 
 
 Procedure. You will need the following: 
 

• e/m apparatus • compass 
• coil current power supply • HV power supply 
• desk lamp • DMM (for coil current measurement) 
• laptop  

 
 The apparatus at your bench should already be completely wired; do not alter the wiring 
unless asked specifically to do so by your instructor. 
 

 v  =  2V e
m
F
HG
I
KJ  (2)

 R =  x + y
2 y

2 2

 (4)

 B IT
A= × −( . )4 23 10 3  (5)
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 With the coil current off, align the apparatus using the compass so that the earth's 
magnetic field is parallel to the plane of the coils; this prevents it from contributing to the beam 
deflection. 
 
1. Turn on the high voltage supply and the current supply for the coils; observe the 

trajectory of the electron beam and notice that the radius of curvature depends on both the 
accelerating voltage V and the current I through the coils. 

 
2. Choose a convenient point (x,y) on the grid as far as possible away from the origin (e.g. 

(10, 2.6)) so that, with V set at 5000 V, the beam can be made to go through this point 
with the coil current available17.  Do not exceed 400 mA of current through the coils!  
Compute the radius R for the point you have chosen, using Eq. 4.  Note that since the grid 
coordinates are in cm, so is your computed value of R. 

 
3. For 5 values of V between 2500 V and 5000 V, record V and the value of the coil current 

I that causes the beam to pass through the point (x, y) that you chose.  Make sure, in each 
case, that reversing the direction of I (by reversing the leads) causes the beam to go 
through (x, −y).  If the deflection is not symmetrical, then you will have to average the 
current required to produce deflections through (x, ±y).  Make a chart in your notebook, 
like the one that follows, to record your data: 

 

V ± ΔV I ± ΔI B ± ΔB e/m ± Δ(e/m) 

1. 

2. 

3. 

4. 

5. 

   
 
 
 
 
 
 

( )e / m e / m± Δ =  

 
Fill in the first two columns with your measurements of V and I together with their respective 
uncertainties (see below). 
 
Analysis. 
 
1. Calculate the magnetic field B produced by each current I by using Eq. 5. 
 

                                                 
17 To read the current, the DMM must be in DC mode (yellow button). 
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2. Calculate a value of e/m for the electron for each of the 5 combinations of V and I, using 
Eq. 3, and record these values in the rightmost column of your chart.  Compute an 
average value of e/m, along with an uncertainty see below). 

 
Uncertainties. 
 
The uncertainty in the measurements of V can be taken as the uncertainty in the meter reading. 
 
The uncertainty in the current I can be considered as arising from the width of the beam. Take ΔI 
as half of the current range for which some portion of the beam passes through the chosen grid 
point. 
 
The propagated uncertainty in B is given in terms of ΔI, according to Eq. 5 and Appendix A, by 
ΔB/B = ΔI/I. 
 
Assume no uncertainty in the radius R of the circular arc. 
 
The uncertainty in the single measurement of e/m calculated from each combination of V and I is 
given by Eq. 3 and Appendix A as 
 

 
 
but recall that the uncertainty in the average value of e/m will be less than that for a single 
measurement.  If the uncertainties in the single measurements (Δ(e/m)) are all the same to one 

sig fig, then the uncertainty in the average of n such values would be (e / m)(e / m)
n

Δ
Δ , 

according to Eqs. 6 & 7 of Appendix A. 
 
Conclusion. 
 
Report your experimental value of e/m, together with your estimated uncertainty. 
 
Calculate the "accepted" value of e/m using accepted values for e and m.  Determine whether this 
value and your experimental value are equal to within your experimental uncertainty. 

 

 
Δ

Δ Δ
e
m
e
m

  V
V

+ 2 B
B

2 2
F
HG
I
KJ

F
HG
I
KJ

= LNM
O
QP
L
NM
O
QP  (6)
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The Oscilloscope 
 

 Introduction.  So far you have used the 
LabPro/Logger Pro combination to observe and record 
voltages as a function of time.  This method of 
observation, however, is limited in terms of the range of 
voltages and frequency (or time scale of the variations) 
that may be explored.  In science and engineering 
laboratories, an oscilloscope is used to observe graphs of 
voltage vs. time (i.e., the waveform) for periodic signals 
with a much wider range of voltage and frequency.  In 
this lab exercise you will have an opportunity to practice 
using the HP 54600B Digital Oscilloscope (pictured at the right) to study signals from a function 
generator—a device that outputs a variety of voltage waveforms with adjustable frequency and 
amplitude.  The goal of this exercise is to prepare you to use these instruments for measurements 
to be performed in the coming weeks. 
 
 Procedure and Analysis.  You will need the following: 

 
• HP 54600B Oscilloscope • cables 
• HP200AB signal generator  

 
Connect the ground (“G”) terminal of the “600 Ω” output of the function generator to the 

GND terminal below the screen on the scope; the other terminal at the far right should be 
connected to the input to channel 1 on the scope.  Turn on the scope and the generator and adjust 
the Volts/div, Time/div and TRIGGER knobs until a stable trace is obtained.  If you have trouble 
getting a stable trace, push the white “Autoscale” button to the right of the screen and press the 
“2” button to turn off that unused input if two traces appear.  If your trace is still jittery, press the 
“Source” button in the trigger area and select “1” as the trigger source18. 

 
Voltage: The peak-to-peak voltage (Vpp) of the wave may be measured in three different 

ways: 
 

(a) Analog.  The vertical voltage scale can be adjusted by the Volts/div knob for the active 
channel and is indicated in the upper left hand corner of the screen.  This number is multiplied by 
the number of big (1 cm) divisions that span the waveform vertically from peak to peak to give 
Vpp. 
 

                                                 
18 The scope takes its cue to begin a sweep from the “trigger” signal, which 
in many cases is best taken from the input itself.  Note also that pressing 
“Autoscale” generally brings up signals from both channels, in which case it 
will be necessary to press “2” until the channel 2 signal (which is just 
noise in this case) goes away. 
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(b) Digital (cursors).  Push the gray “Cursors” button to the right of the screen and select V1 and 
V2 as active cursors with the “softkeys” at the bottom of the screen, respectively aligning the 
cursors (by adjusting the small gray knob) with the upper and lower peaks of the wave.  Vpp is 
then read directly as ΔV below the trace. 
 
(c) Digital (direct readout).  Pushing the gray “Voltage” button and selecting Vp−p with the 
softkeys gives a direct Vpp reading below the trace. 
 
 Time (period and frequency):  The period of the wave is the amount of time elapsed 
between peaks (or between any two corresponding points on successive cycles).  The frequency 

is given as the reciprocal of the period: 1f
T

= .  As with the voltage, there are three ways to make 

time measurements: 
 
(a) Analog.  The horizontal time scale can be adjusted by the Time/Div knob and is indicated at 
the top of the screen (right of center).  The period is the product of the time scale and the number 
of divisions spanning one period of the wave horizontally. 
 
(b) Digital (cursors).  Press the “Cursors” button and measure the time interval between peaks 
with a procedure analogous to (b) under Voltage. 
 
(c) Digital (direct readout).  Pushing the gray Time button and making menu selections can get 
you a direct readout of both period and frequency. 
 
 Measurements:  Fill in the chart below for some different frequency settings of the 
function generator, with the amplitude dial on the highest setting that allows you to see the entire 
signal on the scope screen.  The frequency setting of the generator is read as the product of the 
number on the dial and the power of ten selected by the “range” button.  For columns with a “*” 
at the top, determine the quantity using all of the techniques discussed; unstarred columns refer 
to analog measurements. 
 
NOTE: Every student at the lab table should operate and read the scope for the completion of at 
least one row of the chart. 
 
Generator 
Setting (Hz) 

# of boxes 
for a period 

Time Scale Period* Frequency* # of boxes 
for Vpp 

Voltage 
Scale 

Vpp* 

 200        
 800        
 2000        
 8000        
 20,000        
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 Uncertainties.  For the analog readings, the suggested uncertainty is one-half the 
smallest division on the scope.  (Note that each 1-cm box is divided both horizontally and 
vertically into smaller divisions)  This means that the relative uncertainties for scope 
measurements can be minimized by choosing voltage and time scales that utilize as much of the 
screen as possible. 
 
 For the direct digital readouts, an estimate of the uncertainties can be gleaned from the 
size of the fluctuations in the value of the quantity being measured.  In the absence of 
fluctuations, the number of significant figures in the readout can be your guide.  For cursor 
measurements, the uncertainty has to do with the “play” in the cursor position—how precisely 
can you position the cursor?  The manufacturer’s claims regarding uncertainties are listed in 
Appendix B.  These should be used if they are larger than those determined by other means. 
 
 Conclusion.  Are the results for period, frequency and peak-to-peak voltage, as derived 
from the various methods, consistent?  How reliable is the dial on the function generator for 
setting the frequency of its output? 
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Magnetic Field Mapping 
 

 Introduction.  The Biot-Savart law allows us to calculate the magnetic field B at any point due to any 
distribution of steady or slowly varying currents. In this experiment we will test the predictions of the law by 
measuring and plotting the magnetic field due to three common current configurations: the long straight wire, 
the solenoid, and a pair of Helmholtz coils. In each case you will observe how the magnetic field varies with 
position near the current and compare it with the theoretical prediction. 
 
 The probe we will use to measure the magnetic field consists of a tiny coil wound around a magnetic 
core. The currents that produce the magnetic fields you will study are rapidly varying and sinusoidal, so that 
they produce a rapidly changing magnetic flux through the probe coil. Faraday's law predicts that, for a fixed 
frequency, the peak-to-peak voltage produced between the ends of the coil leads will be proportional to the 
peak-to-peak magnetic field being produced by the current at the location of the probe coil. As the probe is 
moved, this voltage can be read on an oscilloscope as a relative measure of the field strength at different 
locations. A full understanding of the physics of the probe will have to await our discussion of Faraday's law, 
AC tuned LRC circuits, and magnetic materials. 
 
 1. Long Straight Wire.  The magnetic field from a long straight wire carrying a current can be calculated 
either from the Biot-Savart law or from Ampère’s law. The result for the magnitude of the B field at a point 
located a distance r from the wire is 

 0 I 1B
2 r
μ

= ⋅
π

. (1) 

The field vectors are in a plane perpendicular to the wire and point 
tangent to circles concentric with the wire. 
 
 2. The Solenoid.  The solenoid consists of a wire wound in a tight 
helix around a cylindrical form. This is closely approximated by the 
arrangement of contiguous circular current loops shown at the right. The 
z-component of the magnetic field for points along the axis of a solenoid 
of length L, radius a, consisting of N turns each carrying a current I is 
given by the Biot-Savart law as 
 
 

 0
z 2 2

2 2

L Lz zN I 2 2B (z)
2 L L Lz z

2 2

⎛ ⎞
⎜ ⎟− +μ ⎜ ⎟= +⎜ ⎟

⎛ ⎞ ⎛ ⎞⎜ ⎟+ − + +⎜ ⎟ ⎜ ⎟⎜ ⎟⎝ ⎠ ⎝ ⎠⎝ ⎠
a a

 (2) 

with z = 0 at the center of the solenoid.  Since our probe only measures the relative strength of the B field for 
different locations, we can convert Eq. (2) into an expression for the relative field strength Brel by dividing both 
sides by Bz(0), the field strength at the center.  It is also convenient to express the result in terms of the 
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dimensionless coordinate zZ
L

≡ . 

The result for Brel is 

 
( ) ( ) ( ) ( )

2z
rel 2 2 2 2

z

B (Z) 1 2Z 1 2ZB (Z) 4 1
B (0) 4 2 4Z 4 2 4Z

⎛ ⎞− +⎜ ⎟≡ = ρ + ⋅ +
⎜ ⎟ρ + − ρ + +⎝ ⎠

, (3) 

where the ratio of the radius of the solenoid to its length, represented above as 
L

ρ ≡
a , determines how Brel 

varies with distance from the center.  The smaller ρ is for a solenoid (i.e., the more “infinite” it is), the more 
uniform the field is along the length inside the windings and the more rapidly it diminishes outside.  (So for 
values of ρ approaching zero, Brel in the above expression becomes 1 for all values of Z.) 
  
 3. Helmholtz Coils.  When a uniform magnetic field is required over 
an accessible region of space in the laboratory, Helmholtz coils are often 
used, as they were in the e/m experiment. This arrangement, shown at the 
right, consists of two thin circular coils mounted so that they are parallel and 
separated by a distance equal to their common radius a. Each coil has N turns 
that each carries a current I. For this configuration, the axial (z-) component 
of the magnetic field is given by the Biot-Savart law as 

 0
z 3 3

2 22 2

N I 1 1B (z)
2

z 1 z 11 1
2 2

⎡ ⎤
⎢ ⎥
⎢ ⎥μ ⎢ ⎥= +
⎢ ⎥⎛ ⎞ ⎛ ⎞⎛ ⎞ ⎛ ⎞⎢ ⎥+ + + −⎜ ⎟ ⎜ ⎟⎜ ⎟ ⎜ ⎟⎜ ⎟ ⎜ ⎟⎢ ⎥⎝ ⎠ ⎝ ⎠⎝ ⎠ ⎝ ⎠⎣ ⎦

a

a a

, (4) 

where z = 0 halfway between the centers of the two coils.  
 
As for the solenoid, it is more convenient to express the B-field strength relative to its magnitude midway 

between the coils in terms of the dimensionless position zZ ≡
a

: 

 
3/ 2

z
rel 3 3

2 2z 2 2

B (Z) 5 1 1B
B (0) 16

1 11 Z 1 Z
2 2

⎡ ⎤
⎢ ⎥
⎢ ⎥⎛ ⎞ ⎢ ⎥≡ = ⋅ +⎜ ⎟ ⎢ ⎥⎝ ⎠ ⎛ ⎞ ⎛ ⎞⎛ ⎞ ⎛ ⎞⎢ ⎥+ + + −⎜ ⎟ ⎜ ⎟⎜ ⎟ ⎜ ⎟⎜ ⎟ ⎜ ⎟⎢ ⎥⎝ ⎠ ⎝ ⎠⎝ ⎠ ⎝ ⎠⎣ ⎦

. (5) 
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Procedure.  You will need the following: 
 

• B-field mapping apparatus • HP model 200AB audio oscillator 
• Long straight wire • oscilloscope 
• Helmholtz coils with probe guide tube • laptop/Logger Pro 
• Vernier calipers and straight edge • 500:4 impedance matching transformer 

 
 1. Long Straight Wire.  Plug the signal generator output into the “500” terminals of the transformer.  
Attach the probe to the oscilloscope input and attach the long straight wire to the “4” terminals of the 
transformer.  Try to keep the transformer and other magnetic materials away from the probe.  With the sine 
wave frequency setting of the generator (audio oscillator) around 32 kHz, "tune" your apparatus by adjusting the 
frequency carefully so that your signal is maximized while the probe is held in a fixed position near the wire.  
Keep the generator set to this frequency for the entire experiment.  Note that the amplitude of this signal is 
proportional to the amplitude of the magnetic field at the probe. 
 
 Examine the signal from the long wire with your probe by pointing the probe axis in various directions 
(keeping the distance from the tip of the probe to the wire constant!).  Note the probe alignment that gives the 
strongest signal.  What does this tell you about the direction of the B-field from the wire (given that the signal is 
maximum when the direction of the field is parallel to the probe axis)? 
 
 With the probe aligned for maximum signal19, record the voltage peak-to-peak amplitude as given by the 
scope for at least ten different distances20 r between the probe axis and the wire (e.g., from 2 cm to 10 cm in 
steps of 0.5 cm).  You can explore as wide a range of distances as your apparatus will permit, being careful to 
keep the distance of your probe from other parts of the wire circuit large compared to its distance from the 
straight portion of the wire.  Tabulate your data. 
 
 2. Solenoid.  Measure and record the diameter (2a) and length (L) of the solenoid windings.  Mount the 
probe axially with respect to the solenoid on the field mapping apparatus and connect the solenoid windings to 
the “4” terminals of the transformer, which is connected to the audio oscillator.  Working backward from the 
midpoint21 of the windings at z = 0, tabulate the peak-to-peak signal strength vs. distance (z) from the center for 
the range of distances allowed by the probe mount.  Take data every half cm or so at least for 0 z L≤ ≤ .  
 
 3. Helmholtz Coils.  Measure the distance a (which is both the separation between coils and their 
common radius); connect the coils to the “4” side of the transformer.  Mount the probe in the transparent tube 

                                                 
19 The probe should already be mounted in the clamp so that a horizontal line drawn perpendicular 
to the vertical wire that extends through the center of the small probe coil is also perpendicular 
to the probe axis.  No adjustments of the probe seating should be necessary. 
20 Measure the first value of r directly from the wire to the center of the probe and note the 
reading on the reference scale; you can use the reference scale for the rest of the measurements. 
21 The position of the center of the solenoid windings may be determined as follows: Note the Vpp 
reading near the center and advance the probe until the reading decreases by, e.g., 20% and record 
the Vpp reading and the probe location at this point.  Back the probe off to the other side of the 
center until the same Vpp reading is obtained and again note the position.  The average of these two 
positions is the center of the solenoid. 
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along the axis of the coils and, again starting at the center (z = 0), tabulate the peak-to-peak signal strength vs. 
distance from the center for the range of distances allowed by the axial mounting tube. 
 
 Analysis: 
 
 1. Long Straight Wire:  Use LoggerProFile.cmbl to plot the peak-to-peak signal strength (on the y-axis) 
vs. the distance (r) between the probe and the wire (x-axis).  Use Analyze→Curve Fit to try to fit the data to a 
function of the form22 A*r^B.  Is the result consistent with Eq. (1)?  Explain.  Sketch the plotted data and best 
fit curve in your notebook. 
 

 2. Solenoid:  Use your data to tabulate p p
rel

p p

V (Z)B(Z)B
B(0) V (0)

−

−

≡ = for your values of Z ≡ z/L in Logger Pro.  

Try to fit your data (Analyze→Curve Fit→Define Function) to the Biot-Savart expression for Brel in Eq. (3) to 

determine the best fit value of the parameter 
L

ρ ≡
a  for your solenoid.23 (NOTE: You will have to make sure 

that the variable in your curve fit expression for the horizontal coordinate is the same as the name—both 
“Name” and “Short Name”—of  the corresponding data column!)  Calculate ρ from the measurements on your 
solenoid and compare to the fit value.  Sketch the plotted data and best fit curve in your notebook. 
 
 3. Helmholtz Coils:  Tabulate your experimentally determined Brel vs. Z ≡ z/a and use Logger Pro to 
examine the agreement between your data and the theoretical Brel of Eq. (5).  As you did for the solenoid, you 
can use Analyze→Curve Fit→Define Function, but select “Manual” fit (since there are no adjustable 
parameters in the theory) and enter the expression in Eq. (5).  Sketch the data and theoretical curve in your 
notebook and comment on the agreement. 
  

                                                 
22 Note that if there is a substantial amount of noise that does not depend on distance from the 
wire, it may be advantageous to try and fit the Vpp vs. r curve to an expression like A*r^B + C; the 
fitted value of C then represents the constant value of the “pickup” noise.  Try it both with and 
without the “C.”  
23 For the solenoid and Helmholtz coil data, you may find it very advantageous to compose your 
expression in a word processor like Notepad (Start→Accessories) and paste it into the Define 
Function dialog box.  To start you off, the form for the expression of Eq. (3) is: 
sqrt(4*rho^2+1)*((1-2*Z)/(sqrt((4*rho)^2+(2-4*Z)^2))+(1+2*Z)/(sqrt((4*rho)^2+(2+4*Z)^2))) 
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 Conclusion. 
 
 Does your data for the long straight wire support the behavior of the field with distance predicted by 
theory?  Be explicit as to the basis for your answer. 
 
 Are the data for the solenoid and the Helmholtz coils consistent with the Biot-Savart law? 
 
 What did you learn in this lab about magnetic fields produced by current distributions? 
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The Earth’s Magnetic Field 
 

 Introduction.  The direction and magnitude of the earth’s 
magnetic field varies from place to place, as can be seen from Fig. 1.  
In this experiment you will use Faraday’s law of induction and a 
spinning coil apparatus to measure the horizontal and vertical 
components of the earth’s B-field at your location. 
 
 
 If a coil of cross-sectional area A with N turns of wire is set 
spinning about a vertical axis with angular speed ω as shown in Fig. 2, 
then the horizontal component of the earth’s magnetic field (Beh) will 
produce a time-changing flux Φm through the coil: 
 m ehNB AcosΦ = θ , (1) 
where θ is the angle that the compass needle makes with the normal to the 
plane of the coil; the vertical component Bev of the earth’s field produces no 
flux (why?).  Since the instantaneous rate at which θ changes is ω, Faraday’s 
law gives the induced emf ε(t): 

 m
eh

d(t) NB A sin t
dt
Φ

ε = − = ω ω , (2) 

 
if we assume that θ = 0 at t = 0.  We can express ε(t) in terms of the quantities 
you will measure by noting: 
 
(i) The peak-to-peak emf, εpp, that you will measure on the oscilloscope, is just twice the peak value of ε(t) in 
Eq. (2) (achieved when sin t 1ω = ): pp eh2NB Aε = ω . 
(ii) The angular speed ω is given from the period read on the scope as the time between successive peaks of the 

sine wave: 2
T
π

ω = . 

(iii) The effective area A of the coil is given in terms of the average diameter D of the windings:
2DA

4
π

= . 

Substituting all of this back into Eq. (2) and solving for Beh gives 

 
pp

eh 2 2

T
B

N D
ε

=
π . (3) 

 The vertical component of the field, Bev, can be measured in similar fashion with the rotation axis 
aligned parallel to the N-S direction (the direction of Be in the horizontal plane); in this orientation it is the 
horizontal component Beh that produces no flux through the coil.  The expression for the measured Bev is then 
identical to that for Beh in Eq. (3). 
  

 
Figure 1 

ωω

Figure 2 
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Procedure.  You will need the following: 
 

• Spinning coil apparatus (coil+rotator) • bubble level 
• oscilloscope • compass 
• straight edge with cm scale • shielded cable 

 
Measure the average turn diameter D D± Δ of the coil windings; the value of N should be marked on the 

coil (no need to count).  Align the rotation axis vertically as well as possible using the bubble level.  Connect 
the cables from the ground and the coil output to the corresponding oscilloscope inputs. 

 
NOTE: The spinning coil is dangerous.  Exercise caution! 
 
Set the coil spinning, adjust the rotator period to around 50 ms, and observe the voltage signal on the 

scope.  Make sure you can distinguish the signal from the noise: the signal goes away when you turn off the 
rotator or short the leads at the coil!  Also note that this noise can be minimized by increasing the separation 
between the scope and the rotator.  If you wish, put the scope in single sweep mode by pressing “MODE” and 
then the “single” softkey.  This freezes a single sweep on the screen for measurements. 

 
Sketch the (t)ε vs. t curve displayed on the scope.  Measure and record ppε  and T for the sinusoidal emf 

produced by the spinning coil in this orientation.  Also estimate the uncertainties in these quantities (see below).  
Note that you will need to make these measurements by eye using the grid on the scope screen; the signal is 
much too noisy to expect good results from the digital values the scope prints on the bottom of the screen. 

 
Use the compass and the bubble level to realign the coil axis so that it is horizontal and points north-

south.  Repeat the measurements of the emf and the period for the displayed signal and estimate their 
uncertainties. 
 
 Analysis.  Use Eq. (3) to calculate Beh and Bev at your lab station.  Also calculate the magnitude and 
inclination or dip angle θdip (angle below the horizontal) for Be. 
  
 Uncertainties.  The noise on top of the signal should help you estimate uncertainties for both the 
peak-to-peak emf and the period.  Estimate the uncertainty in the turn diameter from the precision of the cm 
scale. 
 
 For the components of Be, the form of Eq. (3) suggests (using Eq. 8(b) in Appendix A): 

 
2 22

ppeh,v

eh,v pp

B T D2
B T D

⎛ ⎞ΔεΔ Δ Δ⎛ ⎞⎛ ⎞= + +⎜ ⎟ ⎜ ⎟ ⎜ ⎟⎜ ⎟ε ⎝ ⎠ ⎝ ⎠⎝ ⎠
 (4) 

 You can calculate the uncertainties in the magnitude and dip angle for Be by using Eq. (8) in Appendix 
A along with ΔBeh and ΔBev given by Eq. (4), or simply use ΔBeh and ΔBev to estimate the range in Be and θdip.  
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 Conclusion.  The National Geophysical Data Center gives values for the earth’s magnetic field at 
different locations (http://www.ngdc.noaa.gov/seg/geomag/magfield.shtml).  For Chico on 7/12/2004, the 
magnitude of Be was 50.79 μT and changing at the rate of −68.58 nT/year.  The inclination was 63.12° and 
changing by −0.026°/year. 
 Do your measured values of θdip and the magnitude for Be agree with this data to within your 
uncertainties?  Are there factors, other than underestimated uncertainties, that would account for a 
disagreement? 
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Electromagnetic Induction Laboratory 
 

 Introduction.  Faraday’s law states that there is an induced emf whenever there 

is a changing flux: md
dt
Φ

= −ε ; Lenz’s law helps to predict the sense (direction) of the 

emf.  This apparently simple statement has a multitude of ramifications that are crucial 
to our understanding of the current electromechanical technology.  The purpose of this 
lab is to present to you several working examples of devices and situations that are tied 
together with the common themes of changing flux and Lenz’s law. 
 
 Procedure.  You will need the following: 

 
• 9 lab stations, as described below  

 
Lab groups will rotate together among the 9 lab stations, as directed by the instructor.  For each station, write a 
description of your observations and a careful explanation, using fundamental principles and clear sketches 
correctly showing polarities, currents, fields, forces, etc. 
 
NOTES: 

1. Please make sure that all power supplies and batteries are disconnected or turned off when not in use! 
2. Some of the meters require a button to be pressed in order to read a voltage/current. 

 
Station #1 includes a permanent bar magnet that can ride a toy car down a ramp through a coil.  The emf 
induced across the ends of the coil can be read with a differential voltage sensor (DVS) connected to a LabPro.  
The file C:\Dietz’s 204B Labs\Electromag Ind Lab\Induced EMF can be used in Logger Pro to collect emf vs. 
time data.  (You can use Experiment→Store Latest Run to compare data curves.)  Don’t let the car hit the floor. 
 Predict: Sketch a graph of the emf vs. time as the magnet speeds through the coil.  Collect data and test 
your prediction. 
 Predict: What will be the effect of changing the height of release for the car on the emf vs. time curve?  
Test. 
 Predict: What happens if the car is turned around so the magnet’s poles are reversed?  Test. 
 
Station #2 is a permanent magnet with a wire or a 1000-turn coil connected to a galvanometer. The wire should 
be moved rapidly through the magnetic field in various ways.  What happens if the wire is wrapped to form a 
coil with a few turns?  How do the effects produced by the wire and the 1000-turn coil compare? 
 
Station #3 has two aluminum pendulums, identical except that one is slotted, to swing between the poles of a 
large permanent magnet. Note the marked difference in damping, and try pushing them rapidly through the 
field. Notice an identical device on the triple beam balance. 
 
Station #4 is the ring toss apparatus with a coil and light. Note the different heights to which the various rings 
jump. Note that one is slotted. Try holding one ring slightly above another floating one, and note the interaction. 
Try the coil and light at various positions. You need only explain the behavior of the light. 
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Station #5 has a dry cell which can be connected briefly and then disconnected from the primary windings of 
two concentric coils. The secondary coil is connected to a galvanometer. Note when you do and do not get 
deflections on the galvanometer, and the directions and magnitudes of these deflections. Try it with the iron 
core in and out of the tube. 
 
Station #6 is a dissectible transformer with a coil connected to a neon bulb. The other coil is to be connected 
briefly to a dry cell. Observe when the bulb flashes and note that you can determine which side of the bulb 
glows and change it by changing the polarity. Try removing the top bar of the rectangular iron core both with 
and without the dry cell connected to the coil. 
 
Station #7 has a coil of wire which can be rotated between the poles of permanent horseshoe magnets. Wires 
are connected to a neon bulb and also to a galvanometer. At which positions do the moving wires produce the 
largest currents? 
 
Station #8 has a coil that can be rotated between iron poles which are magnetized by a stationary coil. The 
stationary coil is connected to a power supply when in use. Brushes can be changed to allow for alternating or 
direct current situations. The movable coil can be rotated by hand with connections to a galvanometer for use as 
a generator, or the coil can be connected to a power supply to be run as a motor.  (Note: Connect the momentary 
key switch in one of the lines to the power supply to avoid continuous use of power.) 
  
Station #9 is an aluminum tube and a plastic tube.  A strong magnet can be dropped either tube. Notice the 
differences in falling times.  (Caution: Keep the magnet away from other magnets and magnetic materials!) 
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RL Circuits 
 
 Introduction.  In this lab you will investigate the way the current through a coil changes when a sudden 
(step) change is made in the applied voltage across its terminals.  You will also observe the AC behavior of the 
current through the coil and observe its action as a frequency filter. 
 
 Inductors, by means of the emf induced across their terminals, act to oppose sudden changes in the 
current they carry; they thus tend to slow down changes in current brought about by sudden changes in a circuit.  
In particular, if the emf across an RL series combination carrying a steady current I0 is suddenly brought to 
zero, the current decays gradually (not suddenly) due to the presence of the inductance L: 
 Lt /

0I(t) I e− τ=  (1) 

where t = 0 when the change is made and L
T

L
R

τ ≡  is the inductive time constant of the circuit.  The resistance 

RT includes any resistor in series with L as well as the resistance of the inductor coil itself.  If an emf is applied 
suddenly to the same circuit, the buildup of current is again gradual, rather than sudden, and is characterized by 
the same time constant: 
 ( )Lt /

maxI(t) I 1 e− τ= − . (2) 

 If, instead of a step change, a sinusoidal (AC) signal voltage with amplitude εm is applied across the 
series resistor-inductor combination, the amplitude of the current (Im) through both elements is given as 

 m
m 2 2

T L

1I
R 1

⎛ ⎞⎛ ⎞ε ⎜ ⎟= ⎜ ⎟⎜ ⎟+ ω τ⎝ ⎠⎝ ⎠
, (3) 

where RT is again the total resistance in the series combination.  Additionally, the current and signal voltage are 
not in phase, but rather exhibit a phase difference φ that is a function of frequency: 
 ( )1

Ltan−φ = ωτ . (4) 
 
 Procedure.  You will need the following: 

 
• laptop/LabPro/Logger Pro • 6V battery supply 
• differential voltage sensor (DVS) • Sencore “ReZolver” 
• current probe (CP) • digital multimeter 
• large inductor (about 700 mH) • momentary switch (S1) 
• cables and alligator clips • impedance matching transformer 
• HP200AB audio oscillator • 100 Ω resistor (RS) 
• oscilloscope  

 
I. Step Changes:  Use the Sencore “ReZolver” to measure the inductance L of the coil24 and the DMM 

to measure the coil’s resistance RL and the resistance RS of the 100-Ω resistor.  Record these values along with 
their uncertainties (Appendix B).  If values are written on the coil itself, don’t believe them! 
                                                 
24 Zero the test leads as described on p. 1 of the rollout instructions and then perform the out-
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Construct the RL circuit shown below; observe the marked polarities and the direction of the current 

probe (CP) arrow.  Connect the current probe (CP) and the Differential Voltage Sensor (DVS) to Chs. 1 and 2, 
respectively, of the LabPro.  Plug in the LabPro power supply and plug the LabPro into the laptop’s USB port. 

 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Bring up Logger Pro and open the C\Dietz’s 204B Labs\RL Circuits\RL Circuit Current Decay file from the 
desktop.  With S1 open, zero both probes.   
 
 Note that after S1 has been closed for a while, a constant current (I0 = ε0/RL) flows through L and RL.  
When it is opened, the emf is taken out of the circuit and this current starts to decay through RS. 
 
 Close S1 by pressing firmly on the key for a couple of seconds so that a steady current flows through the 
RL combination; the live readout for the voltage probe should read close to the battery voltage.  Start the data 
collection and then quickly release the switch after the program indicates it is waiting.  (Note that, for this file, 
data collection is delayed until the program detects a decrease in voltage sensed by the DVS).  You may wish to 
use the Autoscale tool to make the features of the I vs. t curve more visible.  Make sketches of the voltage and 
current vs. time in your notebook. 
 
 Analysis.  Does Eq. (1) adequately describe the decay of the current through the inductor when the emf 
is removed?  Try a curve fit of the decay data to the function Lt /I(t) Ae− τ= with A and τL as free parameters to 
be determined for the best fit.  (Be sure to select only the decaying portion of the curve.) 
 

                                                                                                                                                                                     
of-circuit inductance test described on p. 7, #1.  When measuring inductance with this meter, make 
sure the scope and oscillator are OFF. 

CP

S1 = 6V

L

COIL

RL

DVS

RS

+_

ε0
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 Compute the inductive time constant for this circuit from the values of L, RL and RS measured with the 
meters (see below for the uncertainty in this “theoretical” value of τL).  Compare this value to the time constant 
obtained from the curve fit to I(t). 
 
Close Logger Pro and disconnect the LabPro from the USB port of your laptop. 
 
 II.  Response to AC Applied Voltage:  To study the current that flows when a source of sinusoidal emf 
is applied to an RL series combination, construct the circuit shown below.  The signal on Ch. 2 is the voltage 
across Rs, which by Ohm’s law is proportional to the current I. 
 
 
  
 
  
  
  
 
 
 
 
 
 
 
 
  
(a) Current Amplitude: Turn on the scope and audio oscillator (it needs a few seconds to warm up) and adjust 
the scope for a stable trace using ch. 1 as the trigger source.  Make sure both inputs are DC coupled25.  Adjust 
the time base and vertical scale so a few cycles of both signals are visible on the screen.  Ch. 1 displays the 
oscillating emf ε(t) presented to the series RL combination and ch. 2 displays the voltage across RS, which is 
directly proportional to the current I(t) through the inductor. 
 
Predict: What will happen to the amplitude VmR (½Vpp(2) on the scope) of the voltage across RS if the oscillator 
is adjusted slowly from lower frequency settings toward higher frequencies?  (Look at Eq. (3).)  Note that the 
amplitude εm of the emf ε(t) is supposed to be constant as the frequency is changed. 
 
 Set the oscillator26 at about 500 Hz and set up the scope to measure frequency and peak-to-peak voltage 
for both channels using the “measure” buttons and the softkeys below the screen.  Adjust the amplitude setting 

                                                 
25 To DC-couple an input, press its numbered button on the “VERTICAL” section of the panel and use 
the softkeys below the screen to select DC coupling.  This reduces the amount of extraneous 
capacitance introduced at the scope input. 
26 Try to maximize the distance between the inductor and the scope, oscillator and ReZolver, as the 
lengths of your cables permit. 
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4

to scope ground
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on the oscillator to the smallest amplitude that gives a readable signal.  (Check to see that you will be able to 
maintain εm at this level for all frequencies from 50 Hz to 500 Hz.) 
 
Tabulate (1) the frequency, (2) Vp-p for the ch. 2 voltage (this is 2VmR—proportional to the inductor current 
amplitude) and (3) Vp-p for the ch.1 voltage (the oscillator signal 2εm) as the oscillator is adjusted from about 
500 Hz to 50 Hz in steps of 50 Hz.  If necessary, slightly adjust the amplitude of the oscillator output to 
maintain a constant εm each time the frequency is adjusted. 
 
 Analysis: Test the prediction of Eq. (3) opening LoggerProFile.cmbl and entering the Vp-p (ch.2) 

(y-axis) vs. frequency27 data and trying to fit a curve of the form 
2 2

L

A
1+ω τ

to determine the best-fit values for 

A and τL (remember 2 fω = π ).  How does this value of τL compare with the one you computed from the 
component values?  Make a sketch in your notebook of the best-fit curve with your data points. 
 
 (b) Phase of the Current: You may have noticed by now that the peaks of the current through the 
inductor do not occur at the same times as the peaks of the applied emf ε(t).  The relative phase angle (in 

radians) between the current and applied emf is just t2
T
δ

π ⋅ , where tδ is just the displacement (“shift”) in time 

between the two waves, which have period T. Do the current peaks lead or lag the voltage peaks phase-wise? 
 
 Slowly tune the oscillator from the lowest frequency available to the higher ones and observe how the 
phase angle changes as you change the frequency of the applied emf.  Are your qualitative observations 
consistent with Eq. (4)? 
 
 Uncertainties.  The uncertainty in the “theoretical” value of the inductive time constant calculated from 
the measured values of the inductance L and the total series resistance RT is given from Eq. 8(b) in Appendix A 
as 

 
22

L T

L T

L R
L R

⎛ ⎞Δτ Δ Δ⎛ ⎞= + ⎜ ⎟⎜ ⎟τ ⎝ ⎠ ⎝ ⎠
, (5) 

where the uncertainty in RT is given by Appendix A, Eq. 8(a) as 

 
2 2

T S LR R RΔ = Δ + Δ . (6) 

 
 Conclusion: 
 
1. How does an inductor “react” to sudden changes in a circuit?  Are your measurements consistent with the 
theoretical behavior of an RL combination? 
 

                                                 
27 Engineers frequently plot quantities like log(VmR/εm) vs. log(ω) instead and work with “octaves” 
and “decibels.”  The quantity VmR/εm is referred to as a “transfer function.” 
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2. For AC circuits, in what sense does an inductor-resistor combination act as a “filter?”  If the circuit you 
studied were powered by a stereo amplifier (instead of the oscillator) and the resistor RS replaced by a speaker 
(with the same resistance and an inductance small compared to L), should this speaker be a woofer (for low 
frequencies) or a tweeter (for high frequencies)? 
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The Driven RLC Tuned Circuit 
 

  
 Introduction.  If a sinusoidal emf signal m(t) sin( t)ε = ε ω is 
applied to a series combination of a resistance RT, an inductance L, 
and a capacitance C, a sinusoidal current mI(t) I sin( t )= ω − φ flows 
through all three elements.  The amplitude Im of the current is given 
as a function of frequency f ( 2≡ ω π ) from KVL and phasor analysis 
as 

m
m 2

2
T

I
1R 2 f L

2 f C

ε
=

⎛ ⎞
+ π −⎜ ⎟π⎝ ⎠

. (1) 

As you can see from a plot of Im vs. f at the right, this current 
amplitude (the “response” to the applied emf) is large for only a small range of frequencies.  It is a maximum at 
the resonance frequency f0, given from Eq. (1) as 

 0
1f

2 LC
=

π
. (2) 

Outside of a small range of frequencies f f f+ −δ ≡ − , the amplitude of the current is less than half of what it is at 
resonance.  In terms of component values, Eq. (1) predicts that δf is given by 

 T3Rf
2 L

δ =
π

, (3) 

where RT is the total series resistance.  This frequency range δf (labeled in the plot) is sometimes referred to as 
the full width at half maximum (FWHM) of the response curve. 
 
 As with the RL circuit you studied in the last lab, the current I(t) and the emf ε(t) will not be in phase 
(except, in this case, for emf’s at the resonant frequency f0).  The phase angle φ by which the emf leads the 
current is given from phasor analysis and KVL as 

 L
C

1tan 2 f
2 f

φ = π τ −
π τ

, (4) 

where τL = L/RT and τC = RTC are, respectively, the inductive and capacitive time constants studied in previous 
labs. 
 
 In this lab you will have the opportunity to study the current response Im as a function of frequency and 
the phase difference between the emf and the current in an RLC circuit. 
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Procedure.  You will need the following: 
 

• Sencore “ReZolver” • digital multimeter 
• HP200AB audio oscillator • HP 54600B oscilloscope 
• 5 mH inductor • 5.6-Ω and 33-Ω resistors, one each 
• two 0.1-μF capacitors • laptop 
• French curves • impedance matching transformer 

 
 With the oscillator and the scope off, use the ReZolver to measure and record the component values for 
the capacitors28 and inductors, along with the uncertainties.  Use the digital multimeter to measure the 
resistances RL and RS.  Construct the circuit shown below: 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
Turn on the scope and signal generator and make sure the scope is DC-coupled (see footnote #2 on the RL 
Circuits write-up).  One of the plugs on the “500” side of the transformer should be connected to the terminal on 
the oscillator marked “G,” which should be attached by a jumper bracket to one of the other two terminals; the 
remaining third terminal is connected to the other transformer lead.  The signal on Ch. 1 (VPP(1)) is then the emf 
ε(t) (across the “4” side of the transformer) being presented to the series combination29; The Ch. 2 voltage 
VPP(2) is the voltage across RS, which is proportional (by Ohm’s law) to the instantaneous current response I(t) 
of the series circuit. 
 

                                                 
28 Always discharge the capacitor before connecting it to the analyzer!  Also, make sure that all 
components are disconnected before attempting to measure their values. 
29 Note that the oscillator is modeled here (within the dashed rectangle) as an “ideal” emf in 
series with an internal resistance Rint amounting to about 75 Ω for the HP200AB.  The “step-down” 
transformer impedance-matches the oscillator to the circuit so that εm will be somewhat independent 
of the frequency setting. 
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 With everything connected, you should see a sine wave on each channel.  Display the values of VPP(1), 
VPP(2), and the common frequency f of the waves. 
 
(a) Current Amplitude Response: 
 
Predict: At what frequency f0 will the current amplitude Im be a maximum? 
 
 Use your prediction to search for the resonance by slowly adjusting the oscillator frequency in the range 
near your predicted f0.  Note that at resonance the current amplitude Im will be maximum and the instantaneous 
current I(t) will be in phase with the emf ε(t).  Record the observed value of f0 along with the uncertainties (see 
below).  Also note the value of VPP(1). 
 
 Find and record the frequencies f+ and f− at which the amplitude Im ( PPV∝ across R) is diminished to 
half of its value at f0; estimate your observed FWHM f f f+ −δ ≡ − . 
 
 Produce a graph that shows the behavior of the current Im vs. frequency f.  Note that the amplitude εm 
(indicated as VPP(1)) of the signal output from the signal source does not stay strictly constant2 as the frequency 
is changed; to correct for this you will need to adjust it back to the value it had at resonance for each new 
frequency f. 
  
 Measure and tabulate the frequency along with VPP(2) (keeping VPP(1) constant) at intervals of 
approximately 200 Hz between f− and f+.  Make five measurements on each side of this range (i.e., below f− and 
above f+ ) every 400 Hz or so. 
  
 Use a French curve to sketch a careful graph of VPP(2) ( mI∝ ) vs. frequency f in your notebook
 (use LoggerProFile.cmbl if desired).  Compare the appearance of your graph with that 
in Figure 1.  Use your graph to produce another estimate the resonant frequency f0 along with δf. 
 
Predict: How will f0 (the peak frequency) and δf (the FWHM) of your current amplitude response curve change 
if  
 
(1) A second 0.1 μF capacitor is connected in parallel with the one in your circuit? 
 
(2) Instead of replacing the capacitor, you replaced the 33-Ω resistor with a 5.1-Ω one? 
  
 Try these changes (one at a time) and see whether your predictions were qualitatively correct. 
 
 Analysis: Compare your predicted values of f0 and δf (from Eqs. (2) and (3)) to those observed for your 
circuit.  Are they consistent?  Does your plotted curve resemble the theoretical one? 
 
(b) Phase of the Current: 
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 Qualitatively observe and record what happens to the phase of the current relative to the applied emf as 
you sweep the oscillator frequency from far below resonance to substantially above it.  For what range of 
frequencies does the current lead the emf?  For what range does it lag?  Is this consistent with the prediction of 
Eq. (4)? 
 
 The Lissajous method:  Placing the oscilloscope in “XY mode” allows us to accurately measure the 
phase difference between the signals on the two input channels.  In this mode, the horizontal and vertical 
deflections each represent one of the two voltages applied at the inputs; the result is a Lissajous figure from 
which the phase angle can be calculated.  For two signals of the same frequency, the figure will be an ellipse. 
 
 To use the XY mode press “Autoscale,” then “Main/Delayed,” 
then the “XY” softkey below the screen.  If you are near but not at 
resonance, you will see an ellipse like the one at the right.  The phase 
angle can be measured with the help of the Y-cursors and is given as 

Csin
D

φ = . 

 
 Measure f0 from phase observation:  
 
 Put the scope in XY mode and search for the resonant frequency, 
at which φ = 0.  At this frequency, the figure should degenerate from an 
ellipse to a straight line segment.  Go back to the main display (press the 
“Main” softkey) to read and record the value of f0 ± Δf0 using this 
method.  How does f0 found from this “phase method” compare with the value found from the current 
amplitude response investigation above?  How do these compare with the value predicted from Eq. (2)? 
 
Uncertainties:  Uncertainties in quantities like Vp-p and frequency read on the scope screen can be estimated by 
noting the fluctuations in these displayed numbers. 
 
 For the value of f0 calculated from component values, we have 

 
2 2

0

0

f 1 L 1 C
f 2 L 2 C
Δ Δ Δ⎛ ⎞ ⎛ ⎞= +⎜ ⎟ ⎜ ⎟

⎝ ⎠ ⎝ ⎠
. 

Conclusion.   
 
 In words, describe the response of the RLC tuned circuit to emf’s of different frequencies.  
 
 Do the width and the position of the peak of your observed current vs. frequency curve coincide with 
those predicted from the values of the components?  Can you think of some reasons why your measured δf 
might be larger than the one you calculated from Eq. (3)?  Which components affect the peak position?  Which 
one(s) affect the width?   
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Appendix A: Measurements and Uncertainties 
 
     The establishment or verification of a physical law or the experimental determination of a physical quantity 
usually involves measurement.  A reading taken from the scale on a stopwatch, a meter stick or a voltmeter, for 
example, may be directly related by a chain of analysis to the quantity or law under study; any uncertainty in 
these readings would thus be directly reflected in an uncertainty in the final result.  A measurement by itself, 
without at least a rough quantitative statement as to the uncertainty involved, produces a result of limited useful-
ness.  It is therefore essential that any introductory physics laboratory course include a discussion of the nature 
of experimental uncertainties and the manner in which they should be assigned to experimental results. 
 
1. UNCERTAINTY vs. DISCREPANCY 
 
     When you report the result of a measurement of a quantity x, you should also give the uncertainty Δx, e.g., 
 
                        5.0 m ± 0.1 m 
                        Ü      Ü 
                       x      Δx 
 
The uncertainty tells us how precise you think your measurement is.  It is also often useful to compare your 
result with a "true" or accepted value; the difference between these is the discrepancy and is a reflection of the 
overall accuracy of the measurement. 
 
     An estimate of the uncertainty of a measurement should always be made; a calculation of the discrepancy 
can be made only if an accepted value or result happens to be available for comparison.  The conclusion for an 
experiment should, whenever possible, address the question: Do the uncertainties involved in my 
measurements account for the discrepancies between my result and the accepted one? 
 
 As an example, suppose you do an experiment to measure the acceleration of gravity and you report the 

experimental value ( exp expg g± Δ ) to be 2
m9.75 0.08
s

±  where the “accepted” value is 2acc
mg 9.81
s

= .  As you can 

see from the graphic representation below, the uncertainty expgΔ in the measurement accounts nicely for the 
discrepancy between gexp and gacc. 
 

 
 
2. ORIGINS OF UNCERTAINTIES 
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     Problems which lead to discrepancies between experimental values and "true" values can be placed in two 
general categories: 
 
I.   Systematic Errors are inaccuracies due to identifiable causes and can, at least in principle, be eliminated.  

Errors of this kind result in values for the measured quantity which are consistently either too high or 
too low.  Such errors can be 

 
 a) Theoretical - due to simplifications of the model system or approximations in the equations describing 

it. 
 
 b) Instrumental - e.g., a poorly calibrated instrument. 
 
 c) Environmental - e.g., factors such as inadequately controlled temperature and pressure. 
 
 d) Observational - e.g., parallax in reading a meter scale. 
 
II.  Random Uncertainties are the result of small fluctuating disturbances which cause about half the 

measurements of any quantity to be too high and half to be too low.  It is often not possible in practice to 
identify all the sources of such errors, to evaluate their effects individually or to completely eliminate 
them.  They can, however, often be well characterized mathematically. 

 
 To illustrate the difference between systematic errors and random uncertainties, we consider the 
measurement of the length of time Tf taken for a ball to fall some fixed distance, say 10 m.  Suppose we drop 
the ball about 1000 times and obtain as many values of Tf, rounding each time to the nearest .01 s.  If N(Tf) is a 
function of Tf that represents the number of times a particular measured value of Tf occurs, then a histogram of 
N versus Tf might look like 
 
 
 
 
 
 
 
 
 
 
 
The "best" value for Tf is just the average (mean) value Tf : 

  

 T
N T

f

i fi

 =  
n

i=1

n

∑
 (1)
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where Ni is the number of times the value Tfi appears as a measurement and n is the total number of times the 
ball is dropped.  In this example we see that Tf  = 1.43 s; the discrepancy between this number and the "true" 
value of Tf, if known, would provide a measure of the accuracy of the measurement.  Systematic errors (e.g. the 
reaction time involved in starting and stopping the clock) will affect Tf  and hence the accuracy.  The spread of 
Tf values, indicated by the width of the curve, is a reflection of the precision with which Tf is being measured.  
Random uncertainties contribute to this width and may be attributable, to e.g., small fluctuations of the height 
from which the ball was dropped or to the difficulty in determining the exact moment of impact with the 
ground.  In what follows we discuss the mathematical treatment of such random uncertainties and the role they 
play in reporting laboratory measurements. 
 
3. CHARACTERIZING A SET OF DATA: THE NORMAL DISTRIBUTION   
 
 It is most often the case that repeated measurements of the same quantity will, as in the timing 
experiment example described above, exhibit a spread about the average value related to the random errors 
associated with the measurement process.  If we make "many" (say 106) measurements of a quantity x and plot 
the frequency of occurrence N(x), we quite often obtain a curve that approximates a Gaussian, or normal 
distribution, as pictured below. 
 
 
 
 
 
 
 
 
 
 
 
 
This curve N(x) represents the relative probability with which values of x are obtained as the result of any 
single measurement of this quantity, which may be, for example, the reading of a meter or stopwatch.  The 
analytical expression for such a curve is 

where the parameters μ and σ determine the position and width of the peak, respectively.  The "normalization" 
parameter NO would correspond, in our timing example, to the total number of readings taken from the 
stopwatch. 
 The curve representing Eq. (2) is of importance for the analysis of experimental data because in many 
cases this data is distributed normally and thus has a frequency distribution that can be "fit" to this curve.  The 
more data taken, the better the fit will be.  But for any set of data, regardless of the number of data points or the 
nature of the distribution, we can define quantities which characterize the "best value" and "spread" of the data. 
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 For a set of data points xi, the quantity x  is the mean of all values obtained for x, and is defined by 

where n is the number of measurements.  For data in which each value of xi generally occurs more than once, 
Eq. (1) may provide a more convenient way to calculate the mean value of x.  The "best value" that one finally 
reports for the quantity x is generally its mean, as defined above.  If a large number of normally distributed data 
points are taken, then x_ should be close to the value of μ for which the curve representing Eq. (2) best fits the 
data. 
 
 We can characterize the spread of any finite set of n data points by its standard deviation, symbolized by 
s.d., which we will define as 

The s.d. for a set of data thus represents the square root of the average square of the deviation (i.e., the "rms" 
deviation) that the data points exhibit with respect to their average value.  For a large number of normally 
distributed data points, s.d. ≈ σ, where σ is the value of the parameter of Eq. (2) which produces the best 
description of the data. 
 
4. REPORTING THE VALUE OF A MEASURED QUANTITY 
 
 Because repeated measurements of the same quantity give us, as discussed above, a range of values 
reflecting the random fluctuations inherent in the measurement process, we need to report the result of these 
measurements in a way which reveals not only the best value of the quantity, but also the precision to which we 
are stating it: we report both the best value and the uncertainty.  The distributions discussed above refer to a 
collection of single measurements.  So if we make a single measurement of a quantity x and had some 
knowledge of the single measurement distribution curve, then we could report this value of x as 
 

where x is the single measured value and s.d. is the standard deviation of the single measurement distribution.  
To determine an appropriate value for s.d. without actually making several measurements, we would have to 
know something, a priori, about the single measurement curve; we would either have to be given a value of s.d. 
or we would have to guess. 
 
 Suppose, as is more common, we take n measurements instead of just one.  Intuitively, it seems 
reasonable that the mean value should be reported with a smaller uncertainty than the single measurement 
discussed above.  In fact, if one took many sets of n measurements (all with the same s.d.) and then calculated 
the mean for each set, the distribution of these means would have a smaller standard deviation (denoted S.D.) 
than that for a single measurement (s.d.).  It is not hard to show (from Eq. (8a) below) that 
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What this means is that one could report the result of a set of n measurements as 

so that the uncertainty associated with the average of 5 measurements, e.g., could be reduced by about a factor 
of 2 from the single measurement s.d.  NOTE: The expression above for reporting an average is only meant to 
serve as a guideline in reporting results; it assumes that all uncertainties involved are purely random in nature.  
Systematic errors must always, at some level, be considered, so that in most cases we cannot create an arbi-
trarily small uncertainty simply by taking more and more measurements! 
 
 Relative vs. Absolute Uncertainty.  One often reports the relative (or percentage) uncertainty associated 
with the best value in lieu of the absolute uncertainty Δx = s.d. or S.D.  No units are associated with these 
relative uncertainties, so that these may be used to directly compare the precision of two different 
measurements.  On the other hand, the absolute uncertainty is more convenient for comparing two measured 
values. 
 
Example.  Suppose we make 10 measurements of the period T of a pendulum, and that the results are tabulated 
to the nearest millisecond (ms) as 
TRIAL #  T (s)  TRIAL #  T (s) 
  
1   1.411   6   1.468 
2   1.452    7   1.437 
3   1.403    8   1.446 
4   1.414   9   1.425  
5   1.459  10   1.434 
 
We need to report the best value for T along with the uncertainty, which we assume is due to random 
fluctuations.   For the best value, we have the mean, 

T
T

s
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To estimate the uncertainty, we calculate s.d. from Eq. (4): 
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But since we made 10 measurements, we can report the uncertainty as 

ΔT  S.D.  s.d.
10

  .006 s.≈ ≈ ≈ 0  

Our result for T thus appears as 
 

 S.D.  s.d.
n

≈  (6)

 x S D x s d.
n

± ≈ ±. . .  (7)
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       T = 1.435 s ± 0.006 s (with absolute uncertainty) 
                  or 
       T = 1.435 s ± 0.5 % (with relative uncertainty)  
 
Significant Figures.  A decision must always be made, consciously or otherwise, as to how many significant 
figures should be used to report a quantity x and its uncertainty Δx.  Since uncertainties are merely estimates, it 
is seldom necessary to report Δx to more than 1 significant figure!  The number of significant figures with 
which you report x is often taken to imply its uncertainty, therefore this number must be consistent with the 
explicitly stated uncertainty Δx.   
 
 Rule of thumb for significant figures:  The measurement and the uncertainty should have their last digits 
in the same location relative to the decimal point.  Example: (1.06 ± 0.01) × 103 m. 
 
 Thus, a length stated as 1.0 m ± 0.002 m would present a problem because the stated uncertainty would 
imply that the observer is withholding information by not reporting more decimal places in the length.  A result 
stated as 1.06 m ± 0.2 m reports a length with too much accuracy, given the uncertainty.  If x and Δx imply 
different uncertainties, one of them should be adjusted so that they are both consistent with the largest of the 
two uncertainties. 
 
Guesstimating Uncertainties.  The uncertainty to assign a given single measurement of x depends on the 
technique employed in the measurement, the quality of the equipment used, and the care with which the 
measurement is made.  The number you come up with as Δx for a particular measurement is often quite 
subjective, because only you know what happened during your measurement.  There are a couple of options for 
estimating Δx: 
 
 1. Take several measurements and calculate s.d., as in the example above for T; 
 
 2. Estimate Δx from the nature of the measurement.  For example, when reading a scale, the uncertainty 

is sometimes, but not always, half of the smallest scale division,  but you will encounter situations 
when the scale divisions have nothing to do with Δx.  In other words, you will always have to use your 
judgment. 

 
You will find yourself using option #2 quite often; it's a real timesaver. 
 
5. PROPAGATION OF UNCERTAINTIES 
 
 Quite often the quantity of interest is measured indirectly, i.e., derived from one or more quantities 
which are each measured directly and reported with uncertainties, as discussed above.  In these cases, the 
estimate of the uncertainty in the indirectly measured quantity must reflect the uncertainties associated with all 
of the relevant directly measured ones. 
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 For example, suppose we wish to infer the acceleration of gravity (g) from direct measurement of both 
Tf (the time taken for an object to fall) and of L (the height from which it is dropped).  The equations of 
kinematics tell us that g can be calculated from Tf and L: 

g =  2 L
T 2

f

. 

How, then, do the uncertainties in L and Tf contribute to Δg, the uncertainty in g? 
 
 You will need to know the answer to this question, and to others just like it.  We first give the general 
expression for propagating the uncertainties in directly measured quantities to find the uncertainty in the derived 
result.  We then treat two special cases which occur quite often. 
 
General Case:  Let z be a quantity to be derived from the direct measurement of two independent quantities x 
and y by using the relationship z = f(x,y).  Suppose we were to make small definite (known) errors Δx and Δy in 
the measurements of x and y respectively.  These would show up as an error Δz in z that would be given by 

Δ Δ Δz f
x

x f
y

y≈ +
∂
∂

∂
∂

.  

But because Δx and Δy are actually random uncertainties, a more realistic estimate of the uncertainty Δz is 

 
as can be demonstrated from considerations of probability theory.  Given uncertainties in the two quantities Δx 
and Δy, Eq. (8) can be used to estimate the propagated uncertainty Δz.  The generalization to more than two 
directly measured quantities is straightforward. 
 
Origin of Eq. (8) (Optional):  Consider two independent random variables P and Q, each with an average of zero and with s.d.'s of ΔP 
and ΔQ, respectively.  The s.d. of the sum P + Q (denoted Δ(P+Q)) is, according to the definition of Eq. (4), 

Δ(P+ Q)  =  (P+ Q )2  
 
If we compute the square of this quantity in terms of ΔP and ΔQ, we get 

( (P+ Q) )  =  (P+ Q )  =  P + 2 PQ+ P

 =  P + Q  =  ( P ) + ( Q ) ,

2 2 2 2

2 2 2 2

Δ

Δ Δ

 

 
from which the s.d. for P + Q is 

Δ Δ Δ(P+ Q)  =  ( P ) + ( Q ) .2 2  
Now considering the function z = f(x,y): the uncertainty in z (Δz), will be due to the combined effects of the uncertainty in x (Δx) and 
the uncertainty in y (Δy).  If P and Q represent the effect on z of changes in x and y, respectively, then ΔP and ΔQ, the s.d.'s  for P and 
Q, will be given by 

Δ Δ Δ ΔP =  f
x

x;    Q =  f
y

y,∂
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where Δx and Δy are the s.d.'s, or uncertainties, in x and y.  The spread, or uncertainty Δz in z will then be Δ(P+Q), given above.  
Substitution for ΔP and ΔQ results directly in Eq. (8) for Δz.  It should be noted that this same argument can also be applied to derive 
Eq. (6) above for the uncertainty (S.D.) in the average. 
 
 Many times, it is not necessary to use Eq. (8) directly because the form of the expression for z will fit 
one of two special cases. 
 
Special Case I:  The quantity of interest (z) is given in terms of two directly measured quantities x and y, each 
with their respective uncertainties Δx and Δy, as z = Ax + By.  In this case, the absolute uncertainty in z is given 
by 
 

 
where the "+ " indicates that this expression is easily generalized to the case where z is given as the sum of 
three or more quantities. 
 
Example:  We wish to determine the mass of water, mw, contained in a beaker from independent measurements 
of the mass of the beaker alone, mb, and the combined mass of the beaker + water, mt.  Then mw = mt - mb and 
the uncertainty in the derived quantity mw is 

Δ Δ Δm m mw t b= +( ) ( )2 2 , 
where Δmt and Δmb must either be estimated or determined from repeated measurements of these quantities. 
 
Special Case II:  The derived quantity (z) is the product of powers of measured quantities x and y: z = K xa yb, 
where K is a constant.  In this case we can give the fractional (relative) uncertainty in z as 

where we can again generalize to any number of quantities, as indicated for Eq. (8a). 
 
Example:  If the acceleration of gravity g is given, as discussed above, in terms of L and Tf as g = 2L/Tf

2, what 
is Δg in terms of the uncertainties ΔL and ΔTf?  If g is rewritten as g = 2(L1)(Tf

-2), then we have something that 
fits the form of special case II with x = L, a = 1 and y = Tf, b = -2.  So for the relative uncertainty Δg/g we get 

Δ Δ Δg
g

 =  L
L

+ 4 T
T

2 2
fL

NM
O
QP
L
NM
O
QP  .  

 
Note that because g depends on the second power of Tf but on only the first power of L, the uncertainty in g is 
much more "sensitive" to the uncertainty in Tf than to the uncertainty in L. 
 

 2 2z (A x) (B y)Δ = Δ + Δ +  (8a) 

 Δ Δ Δz
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 =  a x
x

+ b y
y
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 If neither of the special cases applies to the quantity being investigated, it is sometimes possible to 
derive the uncertainty by applying Eq. (8a) and (8b) in combination; otherwise, use the general expression of 
Eq. (8) directly.  
 
Graphs and Uncertainties.  Physical laws often predict that two quantities (x and y) that can be measured 
(directly or indirectly) are proportional to each other.  For example, Newton's second law in one dimension 
(F = Ma) predicts that the acceleration (a) of an object is proportional to the force F (the mass M being the 
constant of proportionality); Ohm's law (V = IR) predicts, for certain materials, that the voltage V and current I 
are proportional.  It is often the constant of proportionality between these measured quantities (M or R in the 
above examples) that is to be determined by the experiment, rather than just individual pairs of values for x and 
y.  The linear relationship between x and y can be expressed as 
 
                    slope 
                   Þ     
 
     
                          Û       
                           y-intercept 
 
If y is plotted vs. x, as in graph (a) below, then the result should be a line with a slope m, calculated as Δy/Δx. 
(Note that here Δy and Δx refer to the rise and run, respectively, not to the uncertainties in y and x!). 
 
 
 
 
Of course, exper- iments being what 
they are, the data points (as indicated 
in graph (a)) will not all be on a 
single line; it is up to you to draw the 
"best" line that "fits" the data so 
that the slope m (or y-intercept b) may 
be determined.  There is a well-known method for determining the best line for a given set of points (x,y) -- the 
least squares fit (see below).  For the purposes of this lab, however, it will often be sufficient to use a straight-
edge and your eyes to draw the line which represents the best compromise, i.e., "comes as close to as many 
points as possible." 
 
 NOTE: If the slope or the intercept is to be measured directly from the graph, it is most often 
advantageous to use as much of the page as possible to draw the graph! 
 
 If the slope m is the quantity to be reported as the result of the experiment, then the uncertainty Δm must 
be reported along with it: we need m ± Δm.  The uncertainty Δm can be thought of as arising from the 
uncertainties in the position of each plotted point on the graph, since each y value may be characterized by an 
uncertainty Δy.  One way of representing these uncertainties is by means of the "error bars" drawn for each 

Δx

Δy

x x

y ym (best fit) = Δx
Δy

(a) (b)

x

(x,y)
_ _
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m
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point on graph (b) above.  As with the slope m, there is a well known (and somewhat complex) expression that 
can be used to determine Δm, but for our purposes it is sufficient to "eye ball" the range of slopes.  As indicated 
in graph (b), this can be done by using the error bars to estimate m+, the highest possible slope for a line that 
passes through or near most of the error bars, and m-, the lowest slope.  The uncertainty Δm is then very 
roughly given by 

Δm m m
≈

−+ −

2
.  

 
 To estimate the slope (m) and its uncertainty (Δm) by eye: 
 
1. Plot the data points (x,y) on graph paper.  Use as much of the page as possible. 
 
2. Place error bars through each point to indicate roughly the extent to which the location of that point on 

the graph is uncertain.  The size of these bars can be estimated from the discussion under the 
"uncertainty" section in each experiment.  An alternative to bars is to enlarge your dot to indicate its 
"fuzziness."  If the uncertainty is too small to show up on your graph, state this in the report. 

 
3. Plot the point ( , )x y  on your graph (where x  and y  are the means of the x and y values, respectively).  

It so happens that this point always lies on the "best line" defined below by the least squares fit 
procedure. 

 
4. Using a straight edge, draw the line passing through ( , )x y  that "comes closest" to the data points.  

Measure the slope m as rise
run

, using as much of the line as possible and paying attention to the units on 

the axis scales. 
 
5. Estimate the uncertainty Δm by drawing 2 dotted lines through ( , )x y  and passing within most of the 

error bars--one with the minimum slope, m−, and one with the maximum slope, m+.  Estimate Δm from 
the expression in the paragraph above. 

 
Least Squares Fit (Linear Regression):  Though somewhat more involved and less intuitive than the graphical 
method described above for finding the slope and intercept of a best fit line, the analytic method of linear 
regression finds the best fit by minimizing the sum of squares of deviations of y values from the fitted straight 
line.  For this reason, it is called the method of least squares.  Given N data points x1, y1; x2, y2; ...; xN, yN, the 
slope m and y-intercept b of the best fit line (given by y = mx + b) are calculated as: 

where x  and y  are the means of the x and y values respectively, given by Eq. (3), and σx is the s.d. of the x 
values as given by Eq. (4). 
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 As an alternative to the graphical method described above for estimating the uncertainty Δm for the 
slope, you may use the least squares methodology to estimate this quantity along with the uncertainty in the 
intercept, Δb.  The expressions for these are 

in which di ≡ yi − (mxi + b) is the y deviation of the point (xi,yi) from the best fit straight line y = mx + b.  If 
your calculator does linear regression calculations which result in the least squares fit slope m and correlation 
coefficient r, then it may be simpler to calculate the uncertainty in the slope (Δm) with the equation* 
 

 
( )( ) 2tan arccos r m 1 rm m

r N 2N 2
−

Δ = =
−−

. (11)  

  
 
 
 
References and further reading: 
 
1. Lichten, William, Data and Error Analysis in the Introductory Physics Laboratory (Allyn and Bacon, 
Inc.)  

                                                 
* J. Higbie, American Journal of Physics, 59(2) 1991 
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Appendix B: Meter and Oscilloscope Uncertainties 
 

Fluke 179:  The rightmost column of the table below indicates the uncertainties to be associated with the 
readings of the Fluke 179 multimeter.  The term [Counts] in the expression for the “Accuracy” at the top refers 
to the value of the least significant figure displayed, which is also the entry in the “Resolution” column.  
Example: For a reading of V = 1.500 V (on the 6.000 V range), ΔV = (0.09% of 
1.500 V) + 2(0.001 V) ≈ 0.003 V.  So record V = 1.500 ± 0.003 V. 
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SENCORE LC103: 
Uncertainties for capacitance measurements: 
For C ≤ 1990 μF: ±(1% + 1 pF  + 1 digit30) 
For 2000 μF ≤ C ≤ 19.99 F: ±(5% + 0.1% of range full scale31) 
 
Uncertainties for inductance measurements: ±(2% + 1 digit + 0.1 μH) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                 
30 The term “1 digit” refers to the change in the value when the least significant figure changes 
by 1.  This is the same as the “resolution” shown above with the full scale readings. 
31 See above for the full scale values corresponding to your readings. 
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 Appendix C: Resistor Color Code 
 
Resistors come in many different sizes, shapes and compositions.  Some are marked with 
four colored bands indicating their resistances in Ohms (Ω), as illustrated below: 
 
 

 
 
 
 
 
 
 
 
 
 
The colored bands labeled A, B, C, and D each represent a digit, and the resistance is 
then given in terms of A, B and C as 
 
 CR AB 10= × Ω  
 
and the tolerance (uncertainty) ΔR/R is indicated by D.  The table below gives the color 
code for the digits: 
 
    Black  0  Green  5 
    Brown  1  Blue  6 
    Red  2  Violet  7 
    Orange  3  Gray  8 
    Yellow  4  White  9 
 
     Gold  (C only) -1 
     Silver  (C only) -2 
 
    Tolerance (D) code: 
     Gold  5% 
     Silver  10% 
     No band 20% 
 
Example: 
 A white (= 9)  B brown (= 1) 
 C red  (= 2)  D silver (10%) 
 

 2 RR = 91 x ;    = 0.110 R
Δ
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The maximum amount of power that a resistor can dissipate without overheating depends 
on the surface area of its body, as indicated in the table below for carbon-composition 
resistors: 
 

LENGTH (") DIAMETER (") POWER RATING (W) 

 1/4 
 
 3/8 
 
 9/16 
 
 11/16 

 0.090 
 
 9/64 
 
 7/32 
 
 5/16 

 1/4 
 
 1/2 
 
 1 
 
 2 
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